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Execu&ve Summary 
     This document describes the WIRC-Pol Version 3.100 so<ware.  The so<ware described in 
this manual is wri?en in Java and is the primary user interface for the WIRC-Pol instrument.  The 
so<ware is accessed from the command line on the newton.palomar.caltech.edu computer.  
StarFng the so<ware is done by opening a terminal window on the newton computer and 
typing "wircpol3.” 
    The so<ware is dependent upon the ArcVIEW server that controls the WIRC camera.  The 
ArcVIEW server is wri?en in LabVIEW and is responsible for controlling the HgCdTe detector and 
wriFng FITS images.  The ArcVIEW server may be run on any of the instrument computers (4-8) 
but requires the fiber and RS-232 connector to be switched to the correct computer. 
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Quick-Start Guide 

 
0.11 Ge'ng started 
 
Open a terminal window and type “wircpol3.”  The system is ready when the green “SYSTEM 
GOOD” icon displays on the “Main Controls” tab. 
 
0.12 Infrared Exposure Parameters 
 
The exposure controls are on the le< side of the main instrument panel: 
 
Exposure Fme (seconds) Minimum exposure Fme is 0.92 seconds. 
Number of Images (integer) You will not see the images update unFl all are complete.  
Coadds (integer)  default = 1    
Fowler Samples (integer) default = 1 
SUR (Sampling-Up-the-Ramp) Only used if the sampling mode is SUR. 
Sampling Mode  Default is Fowler-N, where N is the number of samples.   
      
Note: If you make a change while an exposure is running, the changes won’t be applied unFl the 
next exposure is started. 
 
Data can be retrieved from the following folder (UT date): 
/remote/instrument6/WIRC/yyyymmdd 
 
0.13 Se'ng the filters  
 
The filter wheel controls are on the main panel.  There are two filter wheels: FORE and AFT.  
Select the desired filter in the FORE combo-box then press the associated MOVE bu?on.  Wait 
unFl the move is complete (icon changes back to green from red) and the desired filter is 
displayed in green in the FORE text box.  Follow the same steps for the AFT filter.   
 
Notes:  
The OPEN filter posiFon is installed in the FORE filter wheel and most of the broadband filters (J, 
H, K, etc.) are installed in the AFT wheel.  
When you have completed your observing run, it is good pracFce to set the FORE filter to 
BrGamma and the AFT wheel to J.  This combinaFon of filters blocks light from hi`ng the 
detector.   
 
0.14 FITS headers 
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You can set the Object, Observer, and Object Type in the “COMMENT PARAMETERS” secFon of 
the Main Panel.  You may also add a Comment to the header in the text field to the le< of the 
image number, but you must add the comment before the image acquisiFon is started.  
 
In order to show the FITS header of the currently displayed image, open the Image Display 
(Tools > Image Display Control) and select Image Display Controls > Image FITS Header.  
 
0.15 Calibra&ons 
      
Typically you will need bias, dark, and flat field images.  
 
Biases can be taken a<er the dome is dark in the a<ernoon (typically 3:30 PM), and are taken 
with the minimum exposure Fme with the BrGamma and J filters.  Observers tend to take 20 – 
100 images.   
 
Take dark frames using the same exposure Fmes you intend to use (or did use) while on-sky to 
measure and account for dark current.   
 
Flat field images are used to correct for non-uniform illuminaFon, imperfecFons, or blemishes 
in the filter and/or opFcs.  Flat field images must be taken using the specific filter combinaFon 
that you used during observing (e.g., OPEN and J).  You want approximately 30,000 ADU (60% of 
the full well capacity of the detector, which is around 50,000 ADU).  Flats can be taken with the 
telescope pointed at zenith with the dome closed using lamps (low and high available).  Some 
observers find that twilight flats can improve the flat field correcFon, but they can be a li?le 
hard to acquire as the sky is constantly changing.  A<er selecFng the filter and exposure Fme, 
you can manually take many of your calibraFon images by simply pressing the GO bu?on or 
pu`ng it into conFnuous mode operaFon with the CONTINUOUS bu?on. 
 
You can also write a script to run the calibraFon frames for you.  Ask the support astronomers to 
point you to example scripts that you can modify.  
 
0.16 Focusing 
 
There are two ways you can obtain best focus.  The first is to use the Tools > Image Display 
Control > Autofocus Control dialog to acquire a set of images starFng at a specific focus value 
and incremented by an offset to produce a set of images at different focus values.  The 
autofocus control is embedded into the image display and works using the guide box cursor.  
To focus the system, follow these steps: 

(1) Take an image with reference subtracFon on so you can see the stars in the image.  (See 
secFon 0.17 below.) 

(2) Select a star in the image that is not saturated and has sufficient signal.  Right-mouse 
click on the image and select Guide Box cursor from the menu.  Then le<-mouse click on 
the star to place the guide box about the star. 
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(3) Open the Cross-secFon graph (Auto Guiding > Cross-SecFon Graph) and examine the 
cross-secFon.  If the star is out of focus, the center of the profile will be depressed since 
you are looking at a donut. 

(4) Set the following parameters: starFng focus, focus increment, and number of steps.  
(5) Press the Perform Autofocus bu?on. 
(6) The system will now move the focus to the starFng focus and take an image.  The FWHM 

in RA and Dec will be calculated for the star inside the guide box and plo?ed on the 
graph. 

(7) For each of the specified focus steps, the system will change the focus, take an image, 
and then plot the FWHM unFl all images have been taken. 

(8) The code fits a parabola to the focus vs. FWHM graph in both RA and Dec, calculaFng 
the point of inflecFon for each graph and determines the focus value halfway between 
the two inflecFon points.  Note: If the current focus is too far off the best focus, the 
system doesn’t have the data required to fit a parabola and the resulFng answer is 
nonsensical.   

      
The second method is helpful for tuning up the focus during the night.  Go to the Auto-Guiding 
panel and open the PSF graph.  Follow these steps: 

(1) Put the system in ConFnuous mode. 
(2) Place a guide box cursor on the star you wish to use.  
(3) Open the PSF graph and clear it. 
(4) Go to the Main Panel > Telescope subpanel.  If the system is connected to the TCS, there 

should be two green arrows poinFng in opposite direcFons in the middle of the panel.  
Set the focus increment (between the arrow icons) to some value (e.g., 0.1 or 0.2 mm) 
and then press the le< or right arrow.  

(5) Each press of an arrow icon will move the focus up (right arrow) or down (le< arrow).  
Observe the PSF graph at different focus values unFl you’ve reached minimum FWHM. 
 

Notes: 
The FWHM as a funcFon of focus value or FHWM as a funcFon of Fme graphs can be quite 
noisy.  As a result, you may want to increase your exposure Fme to average out some of the 
variaFon.  Keep in mind that the sky level may be changing very quickly; you may want to wait a 
li?le a<er changing focus for several images to be taken so you can properly assess the effect.   
      
Once you have obtained best focus, you can run the EsFmate Seeing bu?on on the Auto-
guiding.  This is a be?er measure of the FWHM since it fits a Gaussian to every star in the image 
and reports the median. 
 
0.17 SubtracFng a reference image 
       
The SNAP control is a fast way to get an image with sky background subtracFon.  Located at the 
bo?om of the main panel, it will move the telescope by dRA, dDec, take an image, and then 
move back to the original posiFon, take an image, and subtract thesecond image from the first. 
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You can also set the reference image by pressing the Set Reference Image bu?on and then click 
the grey OFF bu?on next to “SUBTRACT REF IMAGE.”  (It will change to green ON.)  If you wish 
to subtract an image that is not currently displayed, choose the Browse for Reference bu?on.  
You can also choose to subtract the median from the image by selecFng the Subtract Median 
radio bu?on.   
    
Note that it is also possible to flat field correct the images as well as subtract a reference.  Go to 
the Tools > Image Display Control > Tools > Image CompensaFon.  The Image CompensaFon 
control allows you to browse for a flat field and to divide the displayed image by the flat field.  
You first need to specify a flat field file which acFvates the Apply Flat Field correcFon bu?on and 
then turn it on.  
 
0.18 Moving a star from one place to another on the array 
 
To use the “Target to Bullseye” funcFon to move a star from posiFon A to posiFon B: 

(1) Right-mouse click on the image to bring up the cursor menu.   
(2) Select the Target cursor. 
(3) Le<-mouse click on the star at PosiFon A. 
(4) Now right-mouse click again and change to the Bullseye cursor.   
(5) Le<-mouse click to place the Bullseye cursor on PosiFon B. 
(6) Go to the Main Panel > Telescope Controls panel.  You will see the calculated offsets 

between the Target posiFon and the Bullseye posiFon as dRA and dDec values at the top 
of the panel.   

(7) If the dRA and dDec look reasonable, you can press the Target to Bullseye bu?on and the 
telescope will move the star from PosiFon A to PosiFon B. 

      
Note:  If you forget to click on the target, the coordinates for the target posiFon may be le< over 
from the last field you observed.  The result is o<en (but not always) extremely large calculated 
dRA and dDec.  This is why it’s a good idea to check dRA and dDec before pressing the Target to 
Bullseye bu?on.  
 
0.19 WriFng scripts 
      
The WIRC-Pol instrument supports a very simple scripFng language.  (See secFon 5.4.)  The 
scripts are simple ASCII files that contain commands followed by parameters.  The best place to 
start when wriFng scripts is opening and modifying exisFng scripts that do something similar.  
For example, you can automate your calibraFons (except for sky flats). 
  
Another example is automaFng mulF-band imaging.  For a science program requiring J, H, and K 
images of mulFple targets, you can write a script that will select the J filter and take an image, 
select the H filter and take an image, and finally select the K filter and take an image.  You can 
write a script that will run a 27-point dither pa?ern in three different filters. 
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0.20  Observing a planetary transit 
       
CreaFng a photometry curve with high precision requires taking one image a<er another using 
the same exposure parameters.  The WIRC-Pol so<ware supports this kind of scenario with a 
simple ConFnuous bu?on that sets the system to take one image a<er another with a minimum 
of overhead.  You could observe a planetary transit by simply placing the star somewhere in the 
image and taking one image a<er another for the duraFon of the experiment.  Unfortunately, 
without acFve correcFon, the star will dri< on the order of 1 arcsecond every 15 minutes.  Most 
of the dri< is in RA dimension but some declinaFon dri< is also observable.  WriFng a 
photometry reducFon pipeline with a target that moves in the image is much more complicated 
than wriFng one that works with guided data.   
     
The best way to observe a transit with WIRC-Pol is to guide.  Take the following steps: 

(1) Take an image and idenFfy the target. 
(2) Place the target where you want it for the observaFons. (See "Target to bullseye.”) 
(3) Take a sky reference image at a different posiFon and set up the system to automaFcally 

subtract the reference image. 
(4) Once you have a reference subtracted image on screen, go to the auto-guiding tab.  You 

can choose the number of guide stars that you want and click the “Locate Guide Stars” 
bu?on. 

(5) Examine the image display and locate the selected guide stars.  You want your guide 
stars to have good signal but not be saturated.  You can delete guide stars by selecFng 
them in the table and pressing the minus bu?on to the le< of the table.   

(6) Go to the main panel and select the ConFnuous bu?on.   
(7) Press the GO bu?on. 
(8) Go back to the auto-guiding panel and press the Guide Graph bu?on.  The graph that 

pops up is conFnuously updated each Fme an image is available.  The graph displays the 
calculated offsets from the original locaFon of the star.  I usually let a few images go by 
and observe the offsets before starFng to guide.  You should see the offsets change for 
each image, on the order of 1 arcsecond or less. 

(9) Go back to the main panel and press the Guide bu?on.  The Guide bu?on controls 
whether the guide correcFons are sent to the TCS (Telescope Control System).    
CorrecFons will not take effect unless the GUIDE bu?on is acFvated. 

(10) The system will conFnue taking images and keeping the target star at its original 
locaFon unFl it’s told to stop.  To stop the observaFon sequence, turn off the Guide 
bu?on and then the ConFnuous bu?on.  Wait for the current image to be completed. 

 
0.21 Dithering 
The WIRC Dither Control is accessible from the Main Panel > Tools menu.  We’ll consider two 
cases: (1) using a canned pa?ern and (2) imporFng your favorite dither pa?ern. 
 
The WIRC-Pol so<ware includes a standard set of about 50 dither pa?erns that are always 
available.  Follow these steps to run a canned pa?ern: 

(1) Open the WIRC Dither Control. 
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(2) Press the Get DSS Sky Image bu?on.  This automaFcally downloads an image from DSS 
from the Palomar Sky Survey that is centered at the current telescope coordinates and is 
15”x 15” arcminutes wide.  (You can change the size if you need to.)  This is an opFonal 
step. 

(3) Press the View Dither Pa?ern bu?on.  This will bring up a control with an image display 
tab and a graph tab.  The image displayed in the control is the image you just 
downloaded from DSS.  The dither pa?ern will appear as an overlay on top of the image. 

(4) The default dither pa?ern is called DITHER_5_SIMPLE.  It’s a pa?ern with one image in 
the center and 4 images at the corners of a square.  The pa?ern can be scaled to 
whatever size you wish by changing the scale factor, which will be reflected in the dither 
overlay on the image. 

(5) Once you are happy with the pa?ern press the GO bu?on on the Dither Control.  The 
pa?ern can be stopped at any Fme by pressing the STOP bu?on that is acFve while the 
dither pa?ern is running.  If the system is acquiring an image when the STOP bu?on is 
pressed, it will ask if you wish to wait for the image to be completed or aborted.  If a 
telescope move is in progress when the STOP bu?on is pressed, the system will wait 
unFl the move has completed before returning to the ready state.   

       
Running a dither pa?ern based on your own pa?ern specificaFon is idenFcal to the steps taken 
above.  The only difference is you need to import your pa?ern and name it so you can select it 
in the combo-box.  To run a dither using your own pa?ern follow these steps: 

(1) A dither pa?ern file is simply an ASCII file containing two columns of numbers separated 
by a delimiter.  The numbers can be interpreted as XY coordinates or as relaFve offsets.   

(2) Press the Open bu?on and browse for the file containing your pa?ern.  The text of the 
file will be displayed in the Manual Dither Editor (le< side text control).  Specify whether 
the pa?ern should be interpreted as absolute coordinates or relaFve offsets.  You also 
need to specify the delimiter.  The most common is the comma and a 10,10 will be 
interpreted as a 10 arcsecond offset/coordinate in RA and 10 arcsecond in Dec. 

(3) Once you have the text of the file displayed and you know the delimiter you can press 
the “Parse” bu?on (i.e., below dither table).  The Parse bu?on reads the text and turns it 
into a series of entries in the dither pa?ern table, one row per file row.   

(4) Verify the resulFng table of offsets or coordinates.  You can edit and parse the text as 
needed. 

(5) Give the pa?ern a name and then press the Add to AcFve List bu?on.   
(6) Press the GO bu?on on the Dither Control.  The pa?ern can be stopped at any Fme by 

pressing the STOP bu?on that is acFve while the dither pa?ern is running.  If the system 
is acquiring an image when the STOP bu?on is pressed, it will ask if you wish to wait for 
the image to be completed or aborted.  If a telescope move is in progress when the STOP 
bu?on is pressed, the system will wait unFl the move has completed before returning to 
the ready state.   

 
Dither pa?erns use all of the specified infrared exposure parameters.  You also can acquire a 
dither pa?ern using any of the filters or any of the mechanism posiFons.  (See polarizaFon 
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mechanisms.)  You can create very complex pa?erns or even maps of the sky to accomplish 
surveys of selected areas.   
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Introduc1on 
     The following document describes the operaFon of the WIRC-Pol instrument using version 
3_100_00 (i.e., version 3.1) of the so<ware.  This manual describes a major update to the WIRC-
Pol control code.  This version is currently deployed on newton.palomar.caltech.edu and is 
started by typing “wircpol3” into a terminal window.  The main goal of this so<ware build is to 
simplify and streamline the interface with parFcular a?enFon to the guiding and dithering 
components.  Dithering has o<en been prone to reliability issues that cropped up when you 
a?empted to stop the execuFon of a dither.  ParFcular a?enFon has been paid to increasing 
reliability and making starFng and stopping execuFon seamless. 
     The main new feature of this build is the creaFon of a system to easily configure guiding.  The 
new system automaFcally idenFfies appropriate guide stars in the acFve image and configures 
the system to guide on the median offset calculated from a set of guide stars.  The number of 
guide stars to use in the calculaFon is an adjustable parameter. 
    The release of version 3.1 will be a major milestone in the development and improvement of 
the WIRC-Pol instrument. 
 

 
Figure 1 WIRC-POL Main GUI Layout 
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2.0 The Main Controls Panel 
     The main panel is the control that you will probably spend the most Fme working with.  If 
you want to take an image, change exposure parameters, or move mechanisms, then you are 
working with the main panel.  The main panel is divided into a set of subpanels, each dedicated 
to a different aspect of instrument control. 
 
2.1 The Infrared Exposure Parameters Panel 
      The infrared exposure parameters panel is in the lower right corner of the main panel and 
contains the following controls: (1) exposure Fme, (2) number of images, (3) number of coadds, 
(4) number of Fowler samples, (5) number of Samples-Up-the-Ramp (SUR), and (6) the sampling 
mode.  The controls in this panel determine how your image will be acquired.  It is not 
necessary to hit a carriage return in the control to have the value take effect.  The so<ware 
waits unFl you press the GO bu?on (to start an exposure) to read the parameter values and 
transmit them to the server.  
     There is a minimum exposure Fme of 0.92 seconds determined by the Fme it takes to read 
out the detector.  The number of images to take is controlled by the “Number of Images” 
spinner.  Be aware that when you use this control to take mulFple images, you won’t see each 
individual image as it’s acquired but only the final image of the set.  For this reason, I o<en use 
the ”ConFnuous Read” bu?on to assist with taking sets of images because it will display each 
individual image as it is acquired; however, you must keep track of how many images have been 
taken and turn off conFnuous read once you have the total number of images you wanted.  The 
coadds spinner controls the number of images that are coadded in the electronics prior to 
wriFng the image to disk.  The use of coadds is extremely important—parFcularly when imaging 
longer infrared wavelengths.   
 

 
Figure 2 Infrared Exposure Parameter Controls 

     The Fowler sampling measures N non-destrucFve reads of the detector immediately a<er 
reset and another N reads at the end of the exposure and differences the values in the 
electronics to reduce read noise.  Fowler samples greater than 1 are o<en used in infrared 
spectroscopy where reducing read noise is criFcal.  With the WIRC instrument, however, it is 
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rare to use mulFple Fowler samples.  (The TSPEC instrument uses a default of 4 Fowler samples 
since the instrument is a dedicated spectrograph.)   
     The SUR spinner controls the number of samples measured when the sampling mode is set 
to SUR (sample mode combo-box below the SUR spinner).  The value of this control has no 
effect if the sampling mode is not SUR.  For a more detailed discussion of SUR please see the IRS 
Instrument Handbook. 
     The sampling mode combo-box allows you to select from 3 different sampling modes: (1) 
Fowler (the default value and overwhelmingly used), (2) Sampling-Up-the-Ramp (SUR), and (3) 
Single Frame.  When SUR mode is selected you need to select the number of samples you wish 
to acquire using the SUR spinner.  For most imaging tasks, the default Fowler sampling mode is 
preferable.  
 
2.2 Exposure Controls 
     The Exposure Controls panel is where you start or stop an exposure.  When the system is 
started and connected to the WIRC server, the GO bu?on is displayed as a large green bu?on on 
the le< side of the main panel slightly above the center line.  The so<ware is essenFally a state 
machine that transiFons from one state to another based on bu?on presses.  When you press 
the GO bu?on, the so<ware reads all of the control values in the GUI and updates the exposure 
parameters in the server and starts an exposure.  While an exposure is in progress, you can 
either let the exposure complete or decide to STOP or ABORT the exposure.  When you select 
STOP, the GUI waits for the current exposure to complete and write to disk before becoming 
ready again.  If you select ABORT, on the other hand, an abort signal will be sent to the server 
and the system is immediately ready for the next exposure. 
     The Exposure Controls panel also contains some very useful addiFonal controls.  The 
ConFnuous Read bu?on toggles the behavior when an exposure is complete.  If the conFnuous 
read bu?on is acFvated, the instrument will immediately begin a new exposure using the same 
exposure parameters when the current exposure is complete.  The system MUST be in 
conFnuous read mode if you intend to guide on an object (e.g. during a planetary transit 
observaFon).  When the conFnuous read bu?on is turned off, the current exposure will 
complete and return to a ready state with the GO bu?on visible.  You can change the 
conFnuous read state at any point during an exposure or set of exposures.  The DS9 bu?on 
controls whether to send the image to a local instance of DS9 a<er it’s wri?en to disk.  Viewing 
the image in DS9 can be useful because the image displayed in DS9 does not have any reference 
image subtracFon or flat fielding applied to it; it is the raw image and should be inspected for 
saturaFon that may not be clear in a background subtracted image.   
    On the right side of the Exposure Control panel are status indicators that display what is going 
on in the server including: (1) idle, (2) rese`ng, (3) exposing, and (4) reading.  These are status 
indicators only and not controls. 
 



 16 

 
Figure 3 Exposure Controls 

     The final control in this panel is the Guide bu?on.  We will go into some detail on how to 
configure guiding later in this manual.  The Guide bu?on on the main panel controls whether 
the calculated guide correcFons are actually sent to the telescope and that is all it does.  You 
can configure guiding and be observing a conFnuous stream of images with the guide correcFon 
being calculated but the correcFons are only sent to the telescope control system (TCS) when 
the Guide bu?on is acFvated. 
 
2.3 Connec&ons 
     The WIRC-Pol so<ware depends upon connecFons to the ArcVIEW server that communicates 
with the Hawaii II detector, and connecFons to the P200 telescope control system (TCS).  These 
connecFons use a TCP/IP protocol and must be made successfully for the instrument to operate.  
The ArcVIEW server supports 3 different kinds of connecFons: (1) command (returns response 
immediately), (2) blocking (only returns when the command is complete), and (3) asynchronous 
messages.  The command socket connecFon is the primary communicaFon pathway and the 
asynchronous socket messages are monitored.  Indicator lights for the connecFon status of each 
socket type are present on the connecFons panel.  The Connect to Detector toggle bu?on in the 
upper le< corner of the panel controls whether the system is connected to the server.  You can 
disconnect from the server by pressing this bu?on and the indicator on the bu?on will turn red.  
All of the socket indicator lights will also show disconnecFon.  Pressing the bu?on automaFcally 
connects all three sockets.  The so<ware automaFcally connects to the server when the 
so<ware is started. 
   It’s relaFvely rare that an observer needs to cycle the socket connecFons.  However, if the 
server was restarted or closed a<er the GUI is started, you may need to assure that the 
connecFons are healthy.   
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Figure 4 ConnecEons Panel - TCS and ArcVIEW connecEons 

     If the server doesn’t connect, it’s possible (although unlikely) that the server hasn’t been 
started or there’s a problem with the startup.  Typically, the WIRC-Pol server runs in the 
ArcVIEW account on instrument6.palomar.caltech.edu, but its locaFon may be changed due to 
issues with the computer.  Please ask the support astronomer if you’re in doubt where the 
server is running.  If the server is NOT currently running, you can use the “Start Server” bu?on.  
The observatory has an applicaFon manager that is used to configure where each of the 
instrument so<ware components is set up to run.  This so<ware maintains a configuraFon file 
that is accessible from any computer system on the instrument network.  Pressing the “Start 
Server” bu?on starts the ArcVIEW server in the locaFon described in the applicaFon manager 
configuraFon file.  If you need to change the locaFon you should probably start the server using 
the applicaFon manager.   
     There are two addiFonal bu?ons in the Detector Electronics ConnecFons panel: (1) update 
GUI and (2) update server.  When observatory personnel are troubleshooFng an issue with the 
instrument, we frequently bypass the GUI enFrely and send commands from a terminal 
window.  This can create a situaFon where the GUI and the server are configured differently.  
Pressing the Update GUI bu?on communicates with the server and updates the GUI with the 
current values in the server.  (For example, if the server has an exposure Fme of 10 seconds, 
and the GUI shows 1.0 second, the server value will update the GUI so that it shows 10 
seconds.)  The Update Server bu?on reads each control field on the main panel and sends the 
associated values to the server.   
      The TCS connecFons panel is used to monitor or cycle the TCP/IP connecFons to the TCS.  
The WIRC-Pol so<ware uses 2 simultaneous connecFons to the TCS: one connecFon to monitor 
the telescope posiFon and telemetry, and one connecFon to send moFon commands (e.g., 
telescope offsets, changes to focus, etc.).  Maintaining simultaneous connecFons allows us to 
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monitor the posiFon of the telescope while it’s moving and tells us when acFons such as focus 
changes are complete.   
       Occasionally the TCS needs to be rebooted during the middle of the night and the 
connecFons to the WIRC-Pol so<ware fail.  Although the so<ware is designed to automaFcally 
reconnect in the event of connecFon failure, if the TCS has been down for more than a few 
minutes, the so<ware eventually gives up trying to reconnect.  In this case, the observer may 
need to reconnect these sockets by toggling the connecFon bu?ons. 
     Finally, the Update bu?on controls whether the telescope telemetry thread is running and 
querying the TCS for its posiFon.  If the bu?on is selected, the TCS will be polled at ~1 Hz.  It 
may be necessary to toggle this bu?on if the TCS has been rebooted. 
 
2.4 Configura&on 
     The configuraFon panel displays the locaFon where the detector electronics server 
(ArcVIEW) is running, and the TCP/IP port numbers used for each of the TCP/IP sockets.  The 
server locaFon selected with the combo-box control determines where the so<ware will 
a?empt to connect to the ArcVIEW server.  Be aware that this control only determines where 
the WIRC-Pol server will look for the ArcVIEW server.  It does not determine where the “Start 
Server” bu?on starts the server if that method is used.  If the applicaFon manager has been 
used to move the server to a different computer, you may need to change where the so<ware 
looks for the server.  For example, if the applicaFon manager moves the server from 
instrument6 to instrument4, the “Server LocaFon” combo-box should be set to instrument4. 
     The details displayed in this panel are stored in the /config/WIRC.ini configuraFon file 
associated with the acFve so<ware build.   

 
Figure 5 ArcVIEW Server ConfiguraEon Panel 

      The addiFonal controls on the configuraFon panel are present purely for informaFon 
purposes and should be modified.  The “Local Path” and “Remote Path” fields are used by the 
code to transform the local name of an image supplied from the server into the actual path to 
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the file on the remote mount so that it can be displayed.  If you have moved the server you may 
need to change the “Remote Path” so that the new remote server path is used in the path 
transformaFon. 
     The “Directory Time Offset” is mainly used for se`ng up the current directory to store 
images.  The directories are constructed when the server is started and are based on the UTC 
date.  The change from one UTC date to another happens in early a<ernoon at Palomar and it’s 
rather inconvenient to have to restart the WIRC-Pol server when the date changes so you have a 
directory with the current UTC date.  Shi<ing the UTC Fme to 4 hours earlier when creaFng the 
directory name means that support astronomers that come in at noon can start up the so<ware 
with the correct directory name for that night. 
 
2.5 Exposure Progress Bars 
   The progress bar panel is located at the top of the main panel.   The three progress bars 
display the percentage of the total read, write, and exposure Fmes.    
 
2.6 Comment Parameters Panel 
     This simple panel allows an observer to add an object name, observer name, and object type 
to be specified and wri?en into the FITS header. 
 
2.7 Image Path and Name Panel 
      The image path and name panel contain the following controls: (1) image path bu?on, (2) 
image path text field, (3) base name text field, (4) image number spinner, and (5) comment.  The 
image path bu?on allows you to open a file browser to specify the directory where the images 
will be stored. In general, this control is not useful for the WIRC-Pol instrument since the server 
and GUI normally run on different systems.  Using the “Image Path” bu?on to change where the 
images are wri?en assumes that both the server and the GUI are running on the same 
computer and can access the same file system.  In most cases, this assumpFon is incorrect so 
this control should not be used unless you’re running the system in an unusual way.   
   The image name is constructed by concatenaFng the base name and the image number and 
the image is wri?en to the image path directory.  For example, if the current date directory is 
/remote/instrument6/WIRC/20230828, the base name is “image,” and the image number is 12, 
the image will be wri?en to /remote/instrument6/WIRC/20230828/image12.fits.   
    The final control is the “Comment” text field.  This control works similar to the controls in the 
comment parameters panel and simply adds the comment keyword to the header with the 
contents of the “Comment” text field.  
 
2.8 Op&cal Mechanism Controls 
      The WIRC-Pol instrument contains a set of optomechanical components including two filter 
wheels, a mask, two slide mechanisms, and two opFcal rotaFon mechanisms.  The filter wheels 
are internal to the WIRC instrument and are controlled individually.  The mask, slide 
mechanisms, and rotators are integral parts of the polarizaFon measurement system (i.e., part 
of the -POL instrument).   
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2.8.1 Filter Wheel Controls 
     The filter wheel controls on the main panel represent the essenFal subset of the controls 
necessary to select filters in each wheel.  The filter wheel components are also represented by a 
more comprehensive control accessible from the “Tools” menu.   
     Each wheel is represented by a filter selecFon combo-box and a Move bu?on.  Simply select 
the appropriate filter in the combo-box then press the associated Move bu?on.  The indicator 
light on the Move bu?on will turn red unFl the move is complete.  The indicator light will return 
to green when the move is completed.  Please only move one wheel at a Fme since the filter 
mechanism is controlled by RS232 communicaFon with the motor controllers and only has 
single thread support.  You should confirm that the selected filters are displayed in the FORE or 
AFT text fields (located below the controls and displayed in green text on a black background) 
a<er the move is complete.  

 
Figure 6 Optomechanical Systems - Main GUI 

     If you click the Move bu?on and you don’t see the filter name in the FORE or AFT displays 
change to the selected filter, you might have a known issue.  If the server has just been started, 
the filter wheel needs to be iniFalized.  The lack of a known filter name in the FORE or AFT text 
fields or name like “unknown” is an indicaFon that the filter wheel doesn’t know where it is and 
requires iniFalizaFon.  If the filter wheels require reiniFalizaFon please see the secFon of the 
manual on the filter wheel control in the Tools menu. 
 
2.8.2 Mask Controls 
    The mask mechanism is used to insert a mask into the opFcal train for polarizaFon 
measurement.  The first step is to iniFalize the mechanism, if it isn’t already.  The IniFalize 
Mechanism bu?on is only available on the Tools > WIRC-Pol Mask Mechanism Control dialog.  
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Once the mechanism is iniFalized, the Insert Mask and Remove Mask bu?ons will be acFvated.  
A<er clicking either the Insert Mask or Remove Mask bu?on, the indicator light on the bu?on 
will turn red and return to green once the move is complete.   
 
2.8.3 PolarizaFon Mechanisms 
     The WIRC-Pol instrument supports polarizaFon measurements using a set of dedicated 
mechanisms connected to a Newport controller.  Two slide mechanisms insert or remove opFcs 
from the opFcal train and 2 rotaFon mechanisms rotate opFcs mounted within the slide 
mechanisms.  
      One of the slide mechanisms inserts a polarizer into the field of view and the associated 
rotaFon mechanism controls its rotaFon angle.  The polarizer was necessary during the 
calibraFon of the instrument’s polarizaFon measurement system; however, both mechanisms 
(i.e., slide and rotator) have been removed from service at this Fme.  The slide mechanism 
supports moving the polarizer in and out of the field.  The rotator has 4 preset angles that are 
the primary angles used during calibraFon: 0, 22.5, 45, and 67.5 degrees.  Moving the rotator to 
an arbitrary angle is supported by the detail control on the Tools > WIRC-Pol Newport Controller 
menu.   
     The other slide mechanism inserts a half-wave plate into the opFcal train and the rotator 
controls its rotaFon angle.  This combinaFon of mechanisms is used for all polarizaFon 
measurements.  (These mechanisms turn WIRC into WIRC-Pol.)  The rotator has 4 preset angles 
that are the primary angles used during observing: 0, 22.5, 45 and 67.5 degrees.  Moving the 
rotator to an arbitrary angle is supported by the detail control on the Tools > WIRC-Pol Newport 
Controller menu.   
      The controls for the polarizer are intenFonally locked since these controls are out of service. 
The controls for the half-wave plate are locked unFl each mechanism is iniFalized using the 
more complete dialog on the Tools > WIRC-Pol Newport Controller menu.   
 
2.9 Telescope Controls 
     The telescope controls panel makes a few of the more commonly used acFons available on 
the main panel.  This panel contains controls for se`ng the focus and for moving the telescope 
with the image integrated target to bullseye and target to mask components. 
 
2.9.1 Target to Bullseye 
          The “Target to Bullseye” control system integrates selecFng coordinates on an image and 
automaFcally calculaFng the telescope move required to move the telescope from one 
coordinate (the Target) to another (the Bullseye).  The image display is accessible on the Tools > 
Image Display Control menu.   
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Figure 7 Target to Bullseye integrated TCS controls 

     The image display control supports a set of cursors that are selected by right clicking on the 
image to bring up the cursor menu.  The two cursors that we are concerned with here are the 
“Target” and “Bullseye” cursors.  Let’s say you have a target that you want in the middle of the 
image and it’s currently well away from the center.  Select the “Target” cursor in the menu and 
then click on the image so that the cursor is directly on your target.  This acFon reads the 
coordinates from the image using the rough WCS transform and stores it internally.  Now switch 
to the “Bullseye” cursor and select where you want the target to appear in the image.  This 
acFon also reads the coordinates from the image and once both the target and bullseye 
coordinates are known, the offset between the two coordinates is calculated.   
     To move the target to the bullseye posiFon simply click the “Target to Bullseye” bu?on and 
the offset move command is sent to the TCS.  The calculated offset between the two 
coordinates in arcseconds is displayed in the GUI and labeled dRA, dDec.  While the telescope is 
in moFon the progress bar under the offsets displays the progress assuming that the telescope 
is moving at 45 arcseconds/second. 
      To make the “Target to Bullseye” moFon work correctly, you must select the target and 
bullseye each Fme you execute a move.  SomeFmes the bullseye cursor is already located 
where you want the target to go but the coordinates of that posiFon may be stale and reflect 
the last Fme the bullseye cursor was clicked on the image.  The bullseye coordinate could be 
halfway across the sky if a long slew was carried out since the coordinates were updated.  
Examine the offset coordinates before you press the “Target to Bullseye” bu?on and make sure 
that they look reasonable for the offset between the two posiFons.   
 
 
2.9.2 Target to Mask 
      The “Target to Mask” funcFon is like “Target to Bullseye” and is used primarily when making 
polarizaFon measurements.  The mask can be inserted into the opFcal train using the Tools > 
WIRC-Pol Mask Mechanism Control menu (SecFon 2.82) or with the controls on the OpFcal 
Mechanisms subpanel on the main panel.  The “Target to Mask” bu?on only requires selecFng 
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the Target cursor and selecFng the target you wish to move to the mask posiFon.  The mask 
posiFon is constant in image XY coordinates, so the code can easily calculate the offset between 
the known mask posiFon and the selected target.  The centerpoint of the mask is stored in one 
of the systems configuraFon files.  Once you select the target with the Target cursor the offset 
between the selected target and the center of the mask is calculated and displayed in the 
telescope controls subpanel and labeled dRA, dDec.  Simply press the “Target to Mask” bu?on 
and the offset will be sent to the telescope control system.  The progress bar will update during 
the move and then return to 0 when the move is complete.   
 
2.9.3 Se'ng Focus 
     The telescope controls subpanel also contains controls to view, change and offset the focus of 
the P200 telescope.  The current focus is displayed to the right of the “Current Focus” label and 
the units are in millimeters.  If you wish to change focus to a parFcular value, enter the value in 
the text field to the right of the “Set Focus” bu?on and then press the bu?on.  The telescope 
move progress bar will display the percent completed of the focus move.  The focus may also be 
offset from the current value using the two controls with green arrows separated by a text field.  
Simply enter the offset (default is 0.0) you wish to make and then press the le< or right arrow 
bu?on.  The le< arrow offsets the focus downward and the right arrow offset the focus upward 
by the amount specified in the text field.  The color of the arrows changes to red while the focus 
change is in progress and returns to green once completed.   
 
2.9.4 FWHM for stars in the guide box 
     Just like the Target and Bullseye cursors, the Guide Box cursor can be selected by right 
clicking on the Tools > Image Display Control frame.  The Guide Box cursor sets a square cursor 
around the selected posiFon and a?empts to fit a Gaussian to the image within the guide box.  
If the code can fit a Gaussian to the contents of the selected porFon of the image, the “Peak Fit 
Status” icon will turn green.  If the code can’t fit a Gaussian, the icon will turn red.  The 
calculated full width at half maximum (FWHM) of the star in the guide box is displayed above 
the “Peak Fit Status” icon and labeled FWHM X and FWHM Y.  The size of the guide box cutout is 
controlled by the spinner control labeled “Guide Box Size.”  The default guide box size is 64 x 64 
pixels.   
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Figure 8 Measuring the FWHM of a star 

 
2.10 Image compensaFon 
      The “Image CompensaFon” subpanel contains a subset of the controls available on the Tools 
> Image Display Control > Image CompensaFon menu.  The more extensive “Image 
CompensaFon” controls can be used to flat field the images automaFcally as well as subtract 
darks or sky reference images.  The most useful sky background subtracFon controls are 
presented on the main panel in this subsecFon.  
 
2.10.1 SubtracFng reference images 
     Imaging in the infrared o<en requires subtracFng a reference image to be?er see the stars in 
the image.  This is parFcularly true for longer wavelengths (e.g. H and K filters).  The raw FITS 
images (i.e., without any image subtracFon) are always wri?en to disk and are the primary data 
product.  When displaying a subtracted image, the image is simply used for display and is 
wri?en to a temporary file in a /temp directory.   
    The observer can choose to use the currently displayed image as the reference image by 
clicking the “Set Reference Image” bu?on.  Alternately, the observer can browse the file system 
to supply the reference image by pressing the “Browse for Reference” bu?on.  If you wish to see 
the full path and name of the file used for image subtracFon, you can access this informaFon on 
the Tools > Image Display Control > Image CompensaFon menu.  The bu?on on the le< side of 
the image compensaFon subpanel controls whether the image subtracFon is executed for the 
next image that will be displayed.  The state of these controls determines the systems behavior 
for the next image taken and all subsequent images.   
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Figure 9 Main GUI - Image CompensaEon 

 
2.10.2 SNAP 
     The SNAP bu?on performs one of the most common operaFons used when acquiring 
infrared images: (1) offset the telescope by a small amount, (2) take an image and set it as the 
reference image, (3) move the telescope back to the original coordinates, (4) take an image of 
the target, and (5) display the current image a<er subtracFng the reference image.  The 
observer may configure how far the telescope offsets in RA and Dec using the dRA, dDEC 
spinner controls.  The default offset is 50 arcseconds in both RA and Dec.   
 
3.0 Auto-Guiding  
     The informaFon in the “Auto-Guiding” panel is also available within the Tools > Image Display 
Control > Guider Control menu except for the “Locate Guide stars” bu?on.  The controls are 
largely duplicated to make them easier to access and to add some automaFon (e.g., locate 
guide stars) to the process. 
 
3.1 Locate guide stars 
      The “Locate Guide Stars” bu?on operates on whatever image is displayed in the Tools > 
Image Display Control window.  The “Locate Guide Stars” bu?on writes the currently displayed 
image (including any reference subtracFon or flat field division) to disk and then runs Sextractor 
on the image to determine the set of stars in the image.  The list is then sorted by the star’s 
brightness and the brightest N stars are added to the Guide Star table.  The number of guide 
stars selected is controlled by the “Number of Guide Stars” spinner located below the “Locate 
Guide Stars” bu?on.  The default number of stars is 5, with a minimum of 1 and maximum of 
10. 
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Figure 10 SeUng up guiding 

 
3.2 Guide star table 
     The guide star table displays the set of guide stars either produced by “Locate Guide Star” or 
by manually adding them to the image (see below).  A Gaussian fit is calculated for each 
selected star and measurements derived from the fit are displayed in the table.  Once the table 
is populated with guide stars, you may inspect the list of stars and remove any stars that aren’t 
appropriate for guiding.  There are several reasons that you might wish to reject a guide star.  
SomeFmes the core of the star is saturated, and including the star will produce an unstable 
measurement of dri<.  Occasionally, the algorithm will select hot pixels or cosmic rays mistaking 
them for stars.  To remove a star from the table, select the row of the table and then press the 
“-” (minus) bu?on to the le< of the table.   
     If you wish to manually add a star to the list: (1) select the guide box cursor on the image 
display (right mouse click to menu), (2) select the “+” (plus) icon on the auto-guiding panel, and 
(3) click on the star in the image display.  Performing this sequence of steps will add a new star 
to the guide box table at the end of the list.  Once you have added all of the stars you wish to 
add, turn off the “+” bu?on.  (If you take an image while the “+” bu?on is acFvated, the system 
will automaFcally add a new star to the table at the locaFon of the current guide cursor.  If you 
do this when the system is in conFnuous imaging mode, it will add a new guide star for each 
image.) 
     The measured locaFon of a star, by either the Gaussian fit (PSF) algorithm or the center of 
mass algorithm, is affected by mechanical dri< of the telescope (which can be corrected) and 
the effect of scinFllaFon on the star’s locaFon due to turbulence in the atmosphere (which 
cannot be corrected).  The changes in the posiFon of a star’s centroid due to scinFllaFon is 
essenFally random and combining mulFple measurements of different stars minimizes the 
effect of scinFllaFon on the guide signal.  It is true that the scinFllaFon may be somewhat 
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constant within an isoplaneFc patch, but selecFng guide stars over the enFre image field tends 
to randomize the effect.  If you want only one guide star, you can either set the number of guide 
stars to one before running “Locate Guide Stars” or just add one star manually. 
      There is no inherent reason you must use the “Locate Guide Stars” bu?on to populate the 
table.  If you know which stars you want to include in the table, you can use the “Plus” bu?on to 
add stars individually.  In general, I recommend examining the cross-secFons for each of the 
selected stars to make sure that they aren’t saturated and to determine if they have sufficient 
signal to noise.  The second column in the guide star table is the “Graph Visibility” column and it 
controls the visibility of the cross-secFon graph for the associated star.  You can easily go 
through the table and make the graph for each star visible.  These graphs are automaFcally 
updated for each image.   

3.2.1 Columns in the Guide Star Table 
Column Name                DescripFon  
Color   Color of the guide box 
Graph Visibility  Cross-SecFon graph visibility 
Chart Visibility                      deprecated, not editable 
Status           Gaussian Fit status 
Image X    X coordinate of fi?ed peak, PSF guide coordinate 
Image Y    Y coordinate of fi?ed peak, PSF guide coordinate 
FWHMX   FWHM in the X direcFon (RA) for this star 
FWHMY   FWHM in the Y direcFon (Dec) for this star 
Center of Mass X     X coordinate of the center of mass, COM guide coordinate               
Center of Mass Y  Y coordinate of the center of mass, COM guide coordinate 
Object Peak   Object peak intensity 
Mean Background               Mean background 
Angle    Angle of the fi?ed 3D Gaussian ellipse   
Mean   Mean value within guide box 
Minimum   Minimum value within guide box 
Maximum    Maximum value within guide box  
Standard DeviaFon  Standard deviaFon of the flux within guide box 
Guide Box X   X coordinate of the upper le< corner of the guide box 
Guide Box Y   Y coordinate of the upper le< corner of the guide box 
Guide Box X size  Width of guide box when created 
Guide Box Y size  Height of guide box when created 

 
     The guide star table consists of descripFons of stars including their posiFon in the image and 
their magnitude.  You can save the list of parameters to disk (“Save Guide Box Array” bu?on) 
and retrieve from disk (“Load Guide Box Array” bu?on).  It is o<en advisable to save the list of 
guide stars and their reference locaFons to disk if you are planning on a long guiding sequence 
(e.g., a planetary transit observaFon).  SomeFmes the weather gets bad for a few minutes, and 
you must close the dome.  SomeFmes you’ll run into a so<ware glitch that requires you restart 
the GUI.  If you wish to have your stars on the same pixels for the enFre observaFon, you can 
save the guide star array and reload it when condiFons improve.  There may be some dri< of 
the telescope while the system wasn’t guiding, so you may need to assure that the stars are 
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within the guide boxes.  If the stars are within the guide boxes, the first correcFon should return 
them to the reference posiFon.   
 
3.3 Table of guide offsets 
       The table of guide offsets contains a single row for each image and displays the UTC Fme 
stamp, the offset in arcseconds from the iniFal reference posiFon calculated for both the 
Gaussian fit algorithm (PSF) and the Center of Mass (COM) algorithm, and the correcFon that 
was sent to the telescope (including the effects of gain and thresholds).  This table is the 
underlying data source for the guide graph.  It does not contain any editable fields and is 
presented for informaFon purposes only.  The guide graph is iniFally hidden and is made visible 
by pressing the Guide Graph bu?on below the table.  The guide graph displays the offset from 
the reference posiFon (Xref, Yref) calculated for each image using both the Gaussian fit (solid 
line) and the center of mass algorithms (dashed lines) as a funcFon of Fme.  The offset in both X 
(RA) and Y (Dec) are displayed for each measurement type for a total of 4 plots.  The remaining 
two plots are the actual guide correcFon that is sent to the telescope based on which algorithm 
is selected (PSF vs COM), the applied gain (i.e., the gain applied to X and Y offsets), and any 
thresholding (i.e., eliminaFng correcFons that are too small or too large).   
     The reference posiFon of the star (i.e., image X, image Y, com X, com Y) is the X, Y coordinate 
of the star when the guide star record is created.  When the system is acFvely guiding, the guide 
correcFon a?empts to keep the star at the same X, Y posiFon as the Xref, Yref.  The calculated 
offsets are the difference between the reference locaFon (created when the guide star was 
created) and the current locaFon.  Since the X, Y centroid calculated by the Gaussian fit and 
COM algorithms may be different, their reference posiFons are different.  SomeFmes it is useful 
to be able to reset the reference posiFon, parFcularly a<er a pause in observing.  For example, 
imagine starFng a light curve observaFon and then having to close the dome a<er 5 minutes of 
observing.  When the dome opens back up you may want to just restart but you’re going to 
forget about that 5 minutes’ worth of data.   
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Figure 11  Autoguiding - turning guiding ON 

 
3.4 Graph visibility buXons 
          There is a set of graphs that are automaFcally created and linked to bu?ons on the auto-
guiding panel.  Three of these bu?ons display graphs linked to the “guide box” cursor on the 
Tools > Image Display Control frame.    

 
Figure 12 Cross-secEon of a star inside a guide box 

3.4.1 Cross-sec;on graph 
     A cross-secFon graph of the star within the guide box is displayed when the associated 
bu?on is selected in both the X and Y direcFons.  The cross-secFon graph is automaFcally 
updated with every mouse click on the image when the guide box cursor is acFve.  The 
cross-secFon graph also updates whenever a new image is displayed.  Whenever the 
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graph is redrawn, the code a?empts to fit a Gaussian to the guide box contents and 
indicates whether the fit was successful in the Auto Guiding > Guide Object Fit subpanel 
using the peak fit status indicator.  The indicator light will be green if a Gaussian can be fit 
to the object in the guide box and turn red if the fit was unsuccessful.  The FWHM in 
arcseconds in X and Y is displayed above the peak status indicator.  Please note that the 
values displayed here are duplicated on the main GUI in the Telescope subpanel. 
 
3.4.2 PSF graph 
      The PSF graph is similarly linked to the guide box cursor on the image display.  As discussed 
in the previous paragraph, the FWHM in both X and Y is calculated whenever the guide box is 
moved and when a new image is displayed.  The PSF graph plots the FHWM in X and Y versus 
Fme.  If the system is running in conFnuous mode, you can use the PSF graph as a manual way 
to tune up the focus.  If you open the PSF graph, place the guide box cursor on a star, and then 
systemaFcally offset the focus using the focus arrows on the Main Panel > Telescope subpanel.  
This method is probably the best way to tune up the focus during the night.  The contents of the 
graph can be cleared by pressing the associated clear bu?on. 
 
3.4.3 Maximum graph 
     The Max Graph displays the maximum within the guide box as a funcFon of Fme.  This graph 
behaves like the PSF graph and displays a new value each Fme the mouse is clicked on the 
image.  This can easily be used to check the relaFve brightness of stars in the image.  If the 
system is in conFnuous mode and the cursor is on a star, you can monitor changes in the 
atmosphere.  The maximum in the guide box tends to reflect changes in the seeing/atmospheric 
turbulence.   
 
3.4.4 Guide graph 
     The guide graph displays the contents of the table of offsets in an offset vs. Fme graph.  The 
graph displays the offsets from the iniFal reference posiFon measured using a Gaussian fit to 
the star (PSF) and by the center of mass (COM) algorithm.  The graph displays the calculated 
offset in both the X (RA) and Y (DEC) direcFons.  The observer can choose which algorithm to 
use when the offsets are sent to the telescope (TCS).  When applying the offsets, the code first 
considers which algorithms to select for determining the offsets and then applies the 
thresholding and gain (See secFon) before sending the correcFon.  The applied offsets are 
depicted as a graph in X (RA, light blue) and Y (Dec, light red) vs. Fme with the area under the 
graph filled in with color.   
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Figure 13 Guide offsets graph 

 
     Why does the so<ware support two different algorithms?  The Gaussian fit algorithm is vastly 
superior in measuring offsets from the reference posiFon for Fghtly focused stars.  
Unfortunately, when the star is defocused to spread the center of the star over more pixels, the 
Gaussian fit may fail.  In this circumstance the center of mass algorithm sFll works properly.  It’s 
important to remember, however, that the COM algorithm requires that the image have the sky 
background subtracted.  The COM algorithm is parFcularly sensiFve to gradients in the image 
and requires a flat background to measure offsets correctly.  
 
3.5 Guiding controls 
       The guide signal is measured by calculaFng the offset from the reference posiFon for each 
star in the guide list and then determining the median offset for a parFcular image.  The control 
loop is a simple proporFonal controller with no derivaFve or integral term.  As a result, the 
observer can influence the guiding by controlling the gain in RA and Dec.  The gains are set by 
default to 1.0 and may be modified by changing the values in the Gain text fields.  It is necessary 
to enter a carriage return when you change the value to propagate the value to the guide 
control loop.   
     Another way you can control the guiding behavior is to change the threshold applied to the 
calculated guide correcFon.  Applying a guide offset takes Fme (at least 100 to 200 milliseconds, 
much longer if the correcFon is large) and it’s wasteful to apply very small correcFons.  The 
threshold parameter is used as a high pass filter to eliminate sending correcFons smaller than 
the specified value.  The default is set to 0.05 arcseconds. The smallest offset that the telescope 
control system (TCS) considers “legal” is 0.007 arcseconds. 
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     By default, the guide loop calculates and applies a guide correcFon for each image.  Since the 
minimum exposure Fme for the WIRC array is 0.923 seconds, it’s possible to provide a guide 
correcFon at between 1 and 2 Hz.  The P200 is a very stable telescope and mechanical dri< has 
consistently been measured at approximately 1 arcsecond every 15 minutes.  Guiding at 1 Hz is 
not necessary and the observer may choose to only apply a correcFon for every other image, or 
even once every 10 images.  The frequency of the applied guide correcFon is controlled by the 
frequency spinner control.  Increasing the frequency decreases the correcFon cadence. 
     The choice of guide algorithm is determined by the selected “Use PSF” or “Use COM” radio 
bu?ons.   By default, the system uses a Gaussian fit to determine the centroid locaFon (i.e., PSF 
algorithm).  The observer may choose to use the center of mass algorithm instead.  Observers 
that have defocused the telescope to increase the number of pixels the light will fall on are 
cauFoned that if the image is defocused too much the Gaussian fit may fail.  The center of mass 
(COM) algorithm requires that the image be background subtracted, so be aware of changing 
background gradients that may push the COM algorithm to generate centroids at the edge of a 
guide box.  
 
3.5.1 Guide box size 
     You can control the size of the guide box cursor on the image display control using the Guide 
Box X and Guide Box Y spinner controls.  The default is 64 x 64 pixels.  Observers are cauFoned 
that making the guide box rectangular breaks the Gaussian fit algorithm, resulFng in the FWHM 
and peak status not being calculated.  You may, however, decrease the size of the guide box, and 
this may be necessary in highly crowded star fields.  
 
3.5.1 FHWM and Peak Fit status 
     The informaFon in the Guide Object Fit panel is idenFcal to SecFon 2.9.4.  Please see this 
secFon for a discussion of the determinaFon of FWHM and Gaussian fit peak status.  
       
3.5.2 Saving and loading the guide box array 
     The list of guide boxes in the Guide Star Table can be saved and then retrieved from a file.  
The informaFon displayed in the Guide Start Table is stored as a comma-separated values (CSV) 
file in the /rdata/TEMP directory.  The file is automaFcally created and is named  
CENTROID_YYYYMMDD_HH_MM.txt.  When you click the “Load Guide Box Array” bu?on it will 
allow you to browse the default directory and select the guide star list to load. 
     An example of when this feature may be useful is when observing a planetary transit on 
mulFple days.  On your first night, you select a set of guide stars and observe the transit with 
them.  This parFcular set of guide stars will a?empt to place the stars at their reference 
posiFons.  At the end of the night, you saved the guide star list to a file.  The next Fme you’re on 
the telescope you realize that it would be nice to place the star in the same place as the last 
Fme you observed.  Observing with the same pixels will increase the consistency of your data 
and may make your data reducFon easier.  Take an image of your field with appropriate 
background subtracFon and then load the guide box array.  You’ll find that the stars probably 
aren’t in the guide boxes.  If you adjust the telescope posiFon (probably by speaking to the 
telescope operator), you can place the guide stars inside the guide boxes.  The stars don’t need 
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to be in the center of the guide box, they just need to be inside them.  The first correcFon done 
when guiding is turned on will return the stars to their reference posiFons.  As a result, the 
target will be placed on the same pixels as during the original observaFon. 
     In addiFon, so<ware crashes are very infrequent, but saving the guide box array allows an 
observer to recover quickly and get their target back to its original posiFon.   
 
3.5.3 Snap to Centroid 
     The Snap to Centroid bu?on controls how the guide box cursor funcFons on the image 
display.  If the indicator icon is red, when the observer clicks on a star on the image, the locaFon 
of the guide box is determined directly by mouse click coordinates.  This locaFon may or may 
not be centered on the star.  In this mode, the star’s profile will show up anywhere in the guide 
box (including near or at the edge) and the accuracy of placement is determined wholly by the 
observers’ mouse clicks.  If the indicator icon is green, the code fits a Gaussian to the guide box 
image, determines the centroid coordinates, and then centers the guide box around the star.  If 
the Gaussian fit fails (e.g., it’s a galaxy not a star, no star is in the guide box, etc.) then the guide 
locaFon defaults to the other behavior (i.e., coordinates determined by the mouse click).   
    
3.6 EsFmaFng seeing 
     You can easily measure the FWHM of any star in a displayed image by placing the guide box 
cursor on the object and the FWHM in RA and Dec will be displayed.  (See SecFon 2.9.4 and 
SecFon 3.5.1.)  However, this just tells you the FWHM for a parFcular star.  The “ESTIMATE 
SEEING” bu?on can give you a good esFmate of seeing in the enFre image. 

 
Figure 14 EsEmaEng seeing 

     The “ESTIMATE SEEING” bu?on performs the following sequence of operaFons on the 
currently displayed image: 

(1) Writes the currently displayed image to disk. 
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(2) Runs Sextractor on the image and reads the list of located stars. 
(3) For each idenFfied star in the image, extracts a guide star postage stamp (i.e., bounded 

by the guide box) and fits a Gaussian to the star. 
(4) If a Gaussian could be fit to the star in the guide box, adds the FWHM in RA and Dec to 

the array of solved stars. 
(5) Once all of the stars have been processed, sorts the array and calculates the mean and 

median FWHM. 
(6) Displays the median of all stars in the image as the seeing esFmate.   
(7) Displays a histogram of the FWHM distribuFon.  (This may require pressing the bu?on a 

second Fme.)  
Examining the histogram can be very useful because it gives you an appreciaFon of the data 
that the seeing esFmate is based on.  Is the histogram sharp with almost all of the 
measurements close to one another?  That’s probably a pre?y good esFmate.  If the histogram 
has a long tail, then the image probably has many galaxies or other non-stellar objects within it.  
Are there many objects with very small FWHM?  This probably indicates that the Sextractor 
parameters are picking up hot pixels or cosmic rays rather than well-focused stars.   

4.0 Server Communica1on 
     The final tab of the main display is dedicated to displaying the communicaFon between the 
GUI and the server.  Each command sent to the server is displayed in blue and the associated 
response is displayed in green.  All communicaFon is carried out primarily using the command 
socket to the server.  The command socket does not block and returns immediately with either 
the result or and indicator that the command was received.  The “conversaFon” that goes on 
between the GUI and the server is displayed in the editor pane on the le< side of the “Server 
CommunicaFon” panel.   
    The right side of the “Server CommunicaFon” panel contains a record of the asynchronous 
messages that the server sends out periodically.  For example, the asynchronous editor pane 
will indicate when an exposure is started and when it’s completed by sending a message to the 
GUI.  These messages are displayed primarily as a debugging aid in case the server runs into 
problems.  SomeFmes you can gain valuable insights into why the system is misbehaving by 
analyzing the conversaFon between the GUI and the server. 
  
 

5.0 The Tools Menu 
 
5.1 Image Display 
     The image display control is accessible from the Tools > Image Display Control menu opFon.  
The image display control is designed to display FITS images automaFcally when they are 
acquired.  Most of the frame is taken up by the FITS image.  You can change the size of the 
image display to whatever you wish by dragging the lower right corner or by grabbing any frame 
edge.  The upper right corner of the image display contains both a zoom window (linked to the 
mouse posiFon) and a pan window.  In the upper right corner of the pan display is a bu?on that 
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will hide the pan and zoom displays if  desired.  If the enFre image is not displayed due to the 
zoom level, a yellow rectangle will appear in the pan window, and you can move this rectangle 
around the pan window to select what porFon of the image will be displayed. 
     The lower le< corner of the frame contains the zoom level controls including: (1) zoom in, (2) 
zoom out, (3) zoom to frame, (4) normal zoom (1x).  Directly to the right of these bu?ons is a 
text field displaying the current zoom level.  This control displays the X, Y pixel coordinates of 
the mouse posiFon and the flux value at that posiFon in the bo?om toolbar.  If the header 
contains WCS keywords, the RA and Dec coordinates are displayed on the right of the toolbar.   
 
5.1.1 Image Controls 
     The Tools > Image Display Control > Image Controls menu contains controls for modifying the 
way the image is displayed.  The most used of these controls is the Image Cut Levels control. 
 

 
Figure 15 Image Display Control 

 
 5.1.1.1 Image cut levels 
     The image cut levels control displays a histogram of the flux values in the displayed image.  
Below the histogram is a bar (like a progress bar) that has triangular “handles” at each end and 
can be dragged le< or right to change the upper or lower ends of the image stretch.  The 
numerical values of the cut levels are displayed under the bar.  There are a set of bu?ons that 
set the limits (upper and lower) at percentages of the measured range.  (See Figure 16 below.)  
At the bo?om right of this control there is a “Median Filter” bu?on that is probably the best 
way to immediately produce a useful stretch of the image.  The “Reset” bu?on sets the limits to 
the measured range (minimum to maximum).  The “Close” bu?on simply closes the dialog. 
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Figure 16 Image Cut Levels Control 

          
 5.1.1.2 Image color map 
    The Image color map control determines which color scale algorithm to use (Linear, 
Logarithmic, Square Root, and Histogram EqualizaFon), with Colormap and Intensity opFons to 
choose from as seen in Figure 17 below. 
 

 
         Figure 17 Image color maps and scaling 

 
5.1.1.3 FITS header  
     The FITS header menu selecFon brings up a table of the FITS header keywords in the 
displayed image.  The table contains columns for the keyword, the value, and the comment 
associated with the keyword. 
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5.2 Overlay Controls 
    The overlay controls menu contains checkbox menu items that determine whether cursors 
and markers on the image are visible.  The following markers’ visibility can be controlled using 
this menu: 

(1) RA-DEC Grid 
(2) ParallacFc Angle 
(3) Target Cursor 
(4) Bullseye Cursor 
(5) Telescope Boresight 
(6) UCAC3 catalog 

     The RA-DEC grid and the parallacFc angle are turned off by default and are turned on by 
checking the box.  The Target and Bullseye cursor are used to move stars from one posiFon in an 
image to another using the linked telescope controls.  The telescope boresight is set at the 
center or the WIRC array.   
 
 5.3 Tools 
      The image display Tools menu provides a set of tools that are linked to the image or require 
image data to funcFon.  Many of these tools (e.g., guider controls, image compensaFon, 
telescope controls) support the backing data structures and funcFons that make controls on the 
main panel work (e.g., image compensaFon).  These controls funcFon in the same way as the 
ones on the main panel and may provide addiFonal capabiliFes beyond those funcFons.  For 
example, the image compensaFon controls on the main panel support background subtracFon 
for the displayed image but not flat field division.  The image compensaFon control supports flat 
field division in addiFon to background subtracFon.   
 
5.3.1 Exposure Controls 
     The Exposure control that is accessed from the Tools > Image Display Control> Tools > 
Exposure Control menu is a small frame containing only the most important controls into one 
small panel.  This control includes an Expose bu?on, a Guide bu?on, and the controls for 
changing focus.  The history of this control is that the telescope operators wanted a very simple 
control that would put only the most essenFal components on a small frame to declu?er the 
desktop.  The control is fully funcFonal, and observers may use it for its original purpose if they 
wish.  
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Figure 18 Exposure Control 

 
5.3.2 Telescope Controls 
     The telescope controls panel is used to offset the telescope.  This control is linked to the 
target and bullseye cursors and displays the RA and Dec coordinates of each, which are based 
on transforming X, Y pixel coordinates into RA and Dec coordinates using the WCS transform 
described by the WCS keywords in the image.  The coordinates of the guide box cursor and the 
targeFng box cursor are also displayed.  Once the target and bullseye cursors are in the desired 
posiFons on the image, click “Move Target to Bullseye.”  The calculated telescope offset 
between the posiFons of the cursors is also displayed to the right of the arrows.  There is also a 
“Move Target to Mask” bu?on that operates in the same way.  (See secFon 2.9.2.) 

 
Figure 19 Telescope Control 
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    If the so<ware is connected to the P200 telescope, the 4 arrow controls turn green in color 
and are enabled.  If the arrow controls are grey and not enabled, it means that the control 
socket to the TCS is not connected.  The arrow controls offset the telescope to move the stars in 
the field the same direcFon as the arrow.  The moFon of the telescope is actually the opposite 
of the desired moFon direcFon.  For example, to move a star up (north), you need to move the 
telescope down (south).  The arrow can be used to move the stars around the image by 
offse`ng by the amount specified in the text field at the center of the arrows.   
      The bo?om of the telescope control displays the current telescope right ascension (RA) and 
declinaFon (Dec) as well as the airmass and the current Cassegrain ring angle. 
 
5.3.3 Autofocus Control 
      The Autofocus control is accessible from the Tools > Image Display Control > Tools > 
Autofocus Controls menu item.  When you open the control, you will see a graph dominaFng 
the le< side of the frame and a table of focus vs. FWHM in both X and Y on the right side.  At the 
bo?om there is a Perform Autofocus bu?on on the lower le< and a progress bar directly below 
it.   
    The Autofocus control is linked to the guide box cursor in the Image Display control.   The 
Autofocus control uses the locaFon of the guide box cursor to extract a subarray for fi`ng a 
Gaussian to determine the FWHM.   When the Perform Autofocus bu?on is pressed, the 
telescope focus is first set to the StarFng Focus value and an image is taken.  Once the image 
has been acquired, the focus is offset by the specified Focus Increment and an image is taken 
again.  This process conFnues unFl the number of images specified by the Steps spinner has 
been acquired.  While the process is running, each Fme an image is acquired, the FWHM of the 
star in the guide box is determined and plo?ed in the graph in both X and Y as a funcFon of 
focus posiFon.  When all of the images have been acquired, the code fits a parabola to the 
curve in X and Y and determines the inflecFon point for each curve (i.e., the minimum) and then 
calculates the best focus.   
 

 
Figure 20 Autofocus Control 
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     The graphs produced by the Autofocus control are obviously based on only one star but they 
can give a reasonable assessment of best focus.  If the curve is very noisy you can use the files 
generated by the Autofocus control to run them through the Focus Graph tool (Tools > 
Sextractor > Focus Graph Analysis) that uses all of the stars in the image to determine best 
focus.   
     The telescope operator will have the focus set to the last best focus for the instrument.  (If 
there is any quesFon about this, you may ask the operator.)  You typically want to produce a 
graph that starts below best focus and extends beyond best focus.  If you think the telescope is 
near best focus you should use a 0.1 mm focus increment and set the starFng focus as follows: 
StarFng Focus = Last Best Focus - ((Steps/2.0)*Focus Increment) 
If the best focus posiFon has not changed, this will produce a parabola centered at the last best 
focus posiFon.  Normally the focus will have changed at least slightly, and the center of the 
parabola will be shi<ed from the previous value. 
 
5.3.4 Guider controls 
     The Guider controls are available on the Tools > Image Display Control > Tools > Guider 
Controls menu.  The funcFonality of this control has been completely replaced by the controls 
now presented on the Auto Guiding tab of the main panel; however, this control sFll supports 
the data structures (i.e., array lists of selected guide stars) used by the newer controls on the 
Auto Guiding panel.   

 
Figure 21 Manual Guider Controls 

     The Guide Star StaFsFcs panel displays metrics calculated for the current posiFon of the 
guide box cursor on the Image Display.  You can control the size of the guide box using guide box 
X and Y spinner controls. 
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      The Guide Star Table panel is used to maintain the currently acFve list of guide stars.  To add 
guide stars to the table, click the plus sign so that it turns green, click on the star on the image 
display using the guide box cursor and the star will be added to the list.  Click on each star you 
wish to add and when you’re done remember to turn the plus sign back off.  If you forget, you 
will get duplicates of the guide stars you just added when a new image is taken.  If you wish to 
remove a guide star from the table, simply click on the row in the guide star table and then click 
the minus sign.  Clicking the minus sign will remove the selected row from the table.  
AddiFonally, there are bu?ons at the bo?om of this panel that can be used to save or retrieve 
the list of guide stars from disk. 
      The Guider Offset Controls Panel contains a table of the calculated offset for each image.  
Each Fme an image is acquired, a new row is added to the table.  The entries in the table are 
Fmestamped and record the offsets calculated by a Gaussian fit (PSF) to the stars’ locaFons and 
offset produced by the center of mass algorithm.   Guide parameters—including the gain in RA 
and Dec and the applied threshold and frequency—can be modified using the controls in the 
upper le< corner of this panel.  Whenever there are guide stars in the table, the offsets will 
automaFcally be calculated, and entries are made to the table; however, the offsets are not sent 
to the telescope unless the GUIDE bu?on is acFvated.  The GUIDE bu?on only controls whether 
offsets are sent to the telescope.  The Start Measurements/Stop Measurements bu?on controls 
whether the calculaFons are carried out.  By default, the system always calculates offsets but 
doesn’t send them to the TCS unless requested.   
    The bu?on of the le< side of the display controls the visibility of the associated graphs.  These 
graphs include the following: 

(1) Cross-secFon graph 
(2) PSF graph 
(3) Guide offset graph 
(4) Maximum graph 

An image of the contents of the guide box cursor are displayed in an image control with an 
associated color bar in this panel, as well. 

 
Figure 22 Image CompensaEon - background subtracEon and flat field correcEon 
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5.3.5 Image compensaFon 
     The Image CompensaFon control is used to configure whether the displayed image will have 
background subtracFon and/or flat field correcFon applied before being displayed.  The 
background subtracFon can be configured from the WIRC-Pol main panel; those controls are 
essenFally mirror those on this panel.  The unique feature of the Image CompensaFon control is 
that it allows you to specify a flat field image and configure the system to divide the incoming 
frames by that image.  To acFvate flat field division, you must provide the path to the flat field 
FITS image by pressing the Browse for Flat Field bu?on and selecFng the image.  Once a flat 
field image is selected, the Apply Flat Field Image bu?on is enabled and may be selected.   
        
5.4 WIRC-Pol Script Controls 
     The WIRC-Pol instrument so<ware supports a very simple scripFng language.  A script is a 
simple ASCII text file that contains one command per line terminated by a newline character 
(\n).  Most commands are a simple keyword (e.g., EXPTIME) followed by a parameter and—in a 
few cases—more than one.  The parameters are always separated from the keyword by a space 
and if more than one parameter is present, the different parameters are also separated by a 
space.   
     The File menu contains a submenu with Open, Save, and Save As opFons.  The Open menu 
opFon brings up a file browser with the default directory as /observer/observer/scripts.  The 
default directory is accessible from all the instrument computers and is the typical place to store 
scripts.  When a file is opened, the enFre file is displayed as text in the Script Editor panel and 
automaFcally parsed into commands and parameters to be displayed in the Commands Table 
panel.  The Commands Table contains one row for each line in the ASCII file and it automaFcally 
assigns line numbers to the script.  The table contains 4 columns: (1) state, (2) line number, (3) 
commands, and (4) parameters.  While a script is running the “STATE” column becomes an 
indicator with a red color indicaFng that the command is currently execuFng.  Once a command 
has been executed, the indicator column turns green.   
 

 
Figure 23 ScripEng Language, EdiEng and ExecuEon 
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     You can use an external text editor to edit, save, and simply reload the file as needed.  The 
best way, however, is to open the Script Editor panel and make any changes you wish.  Once you 
have modified the text, you need to press the Parse Script File bu?on to reparse the file and 
repopulate the Commands Table with the updated values.  Once you have modified a script, you 
can save it to disk with the File > Save or Save As menu opFons.   
     Click the green GO bu?on in the upper right corner of the WIRC-Pol Script Control panel to 
start running the script.  The script will either start at the beginning of the file or on the selected 
line based on the selected radio bu?on in the top panel.  Once the script has started, the GO 
bu?on changes to a PAUSE icon and an addiFonal STOP bu?on is acFvated.  The observer is 
presented with a choice to either pause the execuFon of the script or to stop it completely.  
When you pause the execuFon, the script completes the current step and goes into a paused 
state, then changes the icon to “conFnue.”  If an exposure is currently in progress when you 
click PAUSE, the exposure is completed before the system transiFons to the paused state.  
Similarly, if the telescope is currently moving, the system will wait for the move to be completed 
before entering the paused state.  Stopping the execuFon also works in a similar way; the 
system will complete either an exposure or a telescope move before becoming ready again.   
     There are no “logic” funcFons in the scripFng language.  You can, however, repeat a script.  
There is a spinner control on the upper main panel of the scripFng control that controls how 
many Fmes the script is repeated before the execuFon is complete.  Once the execuFon of the 
script is complete, the GO bu?on will be reacFvated, and the system is ready to run again.  
     Languages can always expand to make new words when the culture demands it.  The 
command set available for controlling WIRC-Pol is extensive, but you sFll might find things you’d 
like to do in a script that aren’t supported.  If you find yourself in this posiFon, please request 
the addiFonal funcFon.  There is a good chance that on your next observing run using the 
instrument, the commands that you requested will be available. 
 

Table of Script Commands 
      

 Options Parameters 
EXPOSURE PARAMETERS   
EXPTIME  exposure time in seconds (floating point) 
COADDS  number of coadds (integer) 
FOWLERS  number of fowler samples (integer) 
NIMAGES  number of images (integer) 
HEADER KEYWORDS   

OBSTYPE  
observation type, which updates the header 
keyword (string) 

OBJECT  
this is the object name used to update the 
OBJECT header keyword 

IMAGE NAME CONSTRUCTION  

BASENAME  
the portion of the image name other than the 
image number 



 44 

IMAGENUMBER  
the image number appended to the end of the 
basename to create the image name 

STATE COMMANDS   

EXPOSE  
executes an exposure with the existing 
parameters 

PAUSE  pause execution of the script 
CONTINUE  continue the execution of the script 
WAIT  wait for N milliseconds (integer) 
TELESCOPE COMMANDS   
FOCUSGO  focus position in mm (floating point value) 

FOCUSINC  
offset the telescope focus by a given amount, 
(floating point number—positive or negative) 

MOVE_TELESCOPE  

offset the telescope by N arcseconds in RA, and 
M arcseconds in Dec (floating point numbers 
separated by a space) 

DITHER COMMANDS   

SET_DITHER_PATTERN  
sets the dither pattern name from the list in the 
dither.ini configuration file 

SET_DITHER_SCALE  
sets the scale factor used to multiply each 
coordinate in the pattern 

RETRIEVE_DITHER_IMAGE  
queries the DSS archive for an image centered at 
the current TCS coordinates 

EXECUTE_DITHER  executes the currently select dither pattern  
LAMP CONTROLS    
LOWLAMP ON/OFF turns the low lamp on or off 
HIGHLAMP ON/OFF turns the high lamp on or off 
ARCLAMP ON/OFF turns the arc lamp on or off 
MECHANISMS   

FILTER FORE/AFT 
combined with a FORE or AFT specification, sets 
the current filter 

POLARIZER IN/OUT 
inserts/removes the polarizer optic into/out of 
the optical path 

WAVEPLATE IN/OUT 
inserts/removes the half-wave plate into/out of 
the optical path 

POLARIZER_ANGLE  sets the rotation angle of the polarizer 
WAVEPLATE_ANGLE  sets the rotation angle of the half-wave plate 

MASK IN/OUT 
inserts/removes the mask into/out of the optical 
path 

 
     Most of the script commands are simple pairings of keywords and values (such as EXPTIME 
and COADDS), but some require mulFple parameters (such as MOVE_TELESCOPE).  Two of the 
polarizer mechanisms, POLARIZER and POLARIZER_ANGLE, are sFll supported in the code but 
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the mechanisms are no longer funcFonal and these commands should not be included in a 
script because the mechanisms cannot be iniFalized.   
    The only commands that may need further explanaFon are the dither commands.  The dither 
control allows an observer to download a DSS (Digital Sky Survey) image of the telescope’s 
current coordinates (RETRIEVE_DITHER_IMAGE).  While it’s not strictly necessary to download 
an image, the observer experience is significantly enhanced if you do.  Downloading a reference 
image allows the observer to follow the execuFon of the dither by displaying an overlay on the 
image that depicts the current state of each requested image.  In general, I recommend 
downloading a reference image, so the system works as intended.  The SET_DITHER_PATTERN 
command accepts any of the names that are accessible from the pa?ern selecFon combo-box.  
One of the most frequent errors encountered is simply misspelling the name of the pa?ern and 
the code can’t find a matching pa?ern to execute.  If you have added your own dither pa?ern to 
the list, you can specify that pa?ern name as well.  Most of the pa?erns are scaled with 
individual offsets between 0 and 1.  You need to apply the SET_DITHER_SCALE command to 
transform the pa?ern to the actual offsets you wish you use.  For example, the 
DITHER_5_SIMPLE pa?ern would offset the telescope by 1 arcsecond to form the pa?ern.  If 
you set the dither scale to 10, the offsets will be 10 arcseconds, for 100 the offsets are 100 
arcseconds, etc.  The dither pa?ern is executed by including the EXECUTE_DITHER command in 
the script a<er the other commands have configured the system.  
 
5.5 Dither Controls 
      The dither control contains a set of predefined dither pa?erns (e.g., 5-point, 9-point 
rectangular pa?erns) that are selected using the combo-box at the upper center of the main 
dither control.  The pa?erns are typically defined by values between 0 and 1 and the executed 
pa?ern is then scaled by the scaling factor in the control directly below the combo-box.  When 
you select a parFcular pa?ern and scale factor, the absolute X, Y coordinates of each dither 
posiFon is presented in a table that dominates the right side of the control.  The table of dither 
posiFons may be edited to modify the absolute coordinate of each dither posiFon.  When you 
edit a dither coordinate, there is no way to make this persistent.  The modified value is acFve as 
long as the current pa?ern is selected but reverts to the default if the selected pa?ern is 
changed.   
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Figure 24 Dither Control - general overview 

     When you select a row in the table using the mouse, the RA and Dec coordinates of that 
posiFon are displayed in the lower panel.  The lower panel displays the current center of the 
dither pa?ern in RA and Dec, the coordinates of the selected dither posiFon in RA and Dec, and 
the relaFve offset in arcseconds required to move to that posiFon.  The “Move to Selected 
Dither PosiFon” bu?on allows the observer to move the telescope to the selected dither 
posiFon.  Using this bu?on, the observer can manually carry out the enFre dither by moving to 
each posiFon in turn and taking an image manually.  The primary use for this funcFon is to fill in 
pa?erns that had to be aborted due to weather issues.  For example, if you completed 7 out of 
the 9 images in a pa?ern when the weather required the dome to close, you can use the “Move 
to Selected Dither PosiFon” bu?on to fill in posiFons 8 and 9 when you are able to resume 
observaFons. 
    The following are the recommended steps for carrying out a dither pa?ern. 

(1) OpFonal: Download a DSS sky survey image.  This is an opFonal step and takes about 30 
seconds.  When you download a DSS image, the system acquires a 30 x 30 arcminute 
image centered at the current telescope coordinates.  The system uses this image as the 
background for displaying the dither pa?ern as it will be executed on-sky. 

(2) Select the dither pa?ern you wish to use from the combo-box. 
(3) Open the “View Dither Pa?ern” display.  If you downloaded an image, the dither pa?ern 

will appear as an overlay on the image.  If you didn’t download an image, you can select 
the graph tab and a chart of the dither posiFons will be displayed. 

(4) Adjust the scale factor.  When you change the scale factor from 1 to some other number, 
the enFre pa?ern is scaled by the entered scale factor.  When you hit the enter key in 
the scale factor control, it forces the pa?ern to be recalculated and the graph and image 
overlay update simultaneously.   
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(5) Examine the image overlay.  Is the pa?ern big enough to cover the observing area of 
interest? Is the pa?ern too large with too much of the field only covered by one or two 
images?  You can adjust the size of the pa?ern by adjusFng the scale factor. 

(6) Is the telescope poinFng exactly where you want it?  You can move the telescope using 
the target to bullseye controls on the image display or you can simply ask the telescope 
operator to offset the telescope.  You can watch the telescope move by watching the 
DSS image and the dither overlay.  Once you’re saFsfied with the selected field, go on to 
the next step. 

(7) An image will be acquired for each dither posiFon using the parameters on the main 
WIRC-Pol GUI.  You can even specify that mulFple images be taken at each posiFon using 
the Number of Images control.  Set up the parameters (such as exposure Fme, coadds), 
the filters, and/or mechanism states prior to actually starFng the dither execuFon. Once 
all of the parameters are specified, go to the next step. 

(8) OpFonal:  Z the telescope offsets.  When you Z the telescope offsets before starFng a 
dither, you can use the telescope display to determine the current offset from the start 
posiFon.   It is not necessary to do this, but it does allow you to monitor the moFon 
during execuFon.  

(9) Press the GO bu?on to start the dither sequence.  The GO bu?on icon will change to 
PAUSE and the STOP bu?on becomes acFve.  The dither posiFon in the table will have its 
execuFon state field turn from grey to red while the exposure is running.  Once an 
exposure is complete, the execuFon state will change to green.  Similarly, the dither 
overlay on the DSS image will have the outline of the current posiFon change to red 
while it’s being observed and then to green once it’s completed.   

(10) While the dither pa?ern is running, the progress bar will show the current 
percentage of the enFre dither pa?ern that has been completed.  The current dither 
posiFon number will also be displayed to the right of the STOP bu?on. 

(11) While the dither is execuFng, the observer may PAUSE the execuFon of the 
pa?ern at any point.  When the PAUSE bu?on is pressed, the icon changes to CONTINUE.  
Note that the system will finish whatever step it is currently execuFng before truly 
becoming paused.  If an exposure is execuFng, it will complete before the system enters 
the paused state.  Similarly, if the telescope is moving, the move will be completed 
before the system becomes paused.  Pressing the CONTINUE bu?on when it is acFve will 
resume the pa?ern with the next step in the sequence (i.e., either exposure or telescope 
move).  The STOP or PAUSE bu?on acFvated during a telescope move always allows the 
move to complete before transiFoning to the next state (i.e., either paused or stopped).  

(12) The STOP bu?on  brings up a dialog box that asks if you wish to complete the 
current exposure or to abort it.  When you press STOP during an exposure, you can 
choose to stop immediately and ABORT the current exposure or wait for the current 
image to be completed.  If you choose to wait, the PAUSE and STOP bu?ons are disabled 
unFl the current exposure is complete.  Once the system has stopped, the GO bu?on is 
acFvated again and the colors of the execuFon state and dither overlays return to the 
defaults.   
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     The default set of dither pa?erns is extensive (~ 38 in number) with the 5-point and 9-point 
rectangular pa?erns being the most used.  There is a rather large set of 5-point and 9-point 
random dithers that can be selected, as well.  In some cases, a random pa?ern eliminates some 
data reducFon problems where the rectangular pa?ern imprints on the result.  There are also 
three 27-point pa?erns that were randomly generated for the same reason.  If you intend to use 
a parFcular pa?ern repeatedly and would like it added to the defaults, please inform the 
support astronomer and they can request that it be added to the defaults.  What if none of the 
default pa?erns work for your observing?  See the next secFon. 
 
5.5.1 Edi&ng a Dither PaTern 
     A dither pa?ern is essenFally an ASCII text file containing two columns of numbers.  The 
columns may be separated by any delimiter with the most common being the comma, space, 
and tab.  Almost everyone has a parFcular dither pa?ern that they have used in the past that 
they like.  There are hundreds of files in the /obs/obs/dither directory that describe different 
pa?erns.  Observers are free to place dither definiFon files in folders they create.  The Manual 
Dither Editor tab contains controls to read dither definiFon files and make them available during 
observing.   
 

 
Figure 25 Dither Controls: EdiEng a Dither file 

    The Manual Dither Editor works with ASCII files that are stored in the /obs/obs/dither 
directory.  Not all of the dither pa?ern files in this directory can be read, but most of them work 
if you select the correct delimiter.  To edit an exisFng dither definiFon file, press the Open 
bu?on and you can browse to the locaFon of the file.  Once the file has been opened, the file’s 
contents will be displayed in the text area on the le< side of the dialog.  The format of the file 
should be quite simple: two columns of numbers separated by a character.  You can specify 
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what the delimiter is using the set of radio bu?ons below the text area.  The default is a comma 
as the delimiter, but many files use either a space or a tab.  Once you’ve selected the delimiter, 
click the Parse bu?on to convert the text into a table of offsets or posiFons (relaFve vs. absolute 
coordinates).   
    All dither pa?erns are centered at the current telescope coordinates as the 0,0 posiFon.  If 
the pa?ern is interpreted in absolute terms, then each line represents the X,Y posiFon of the 
dither posiFon relaFve to the current telescope coordinates.  If the pa?ern is interpreted in 
relaFve terms, then each line represents the offset to the next posiFon in the pa?ern.  The code 
can easily transform relaFve coordinates to absolute coordinates and vice versa.   
     The area containing the text to parse supports ediFng so you can make any changes to the 
file.  You can use ctrl-X, ctrl-C, ctrl-V, etc. to copy, cut, and paste within the text area.  You will 
need to re-parse the file a<er ediFng so the changes show up in the table.   
     Once you are happy with the way the system parsed your dither file, you need to add the 
dither to the list of available pa?erns.  When you press the “Add to acFve list” bu?on the 
system adds the dither pa?ern to the end of the list of selectable pa?erns and automaFcally 
selects it.  Using the DSS image display visualizes the pa?ern and uses the scale control to 
modify the way the pa?ern appears on the sky.  A dither pa?ern must have a name; the name is 
determined by the entry in the text field to the right of the “Apply to acFve list” bu?on.  If the 
pa?ern name you specify conflicts with an exisFng dither name, a dialog will pop up and 
request that you change the name to a unique, unused idenFfier.  
 
5.5.2 Image Dither Editor 
     The “Dither Image Editor” is a unique way to specify a dither pa?ern.  This control is linked to 
the DSS image display and allows you to create a pa?ern using the mouse.  To use this control, 
you need to download an image of the current telescope posiFon and open the image viewer. 
You can create a custom dither pa?ern using the following steps. 
 

(1) Make sure the telescope is tracking. 
(2) Download a DSS image of the field. 
(3) Open the DSS image display.  
(4) Open the “Dither Image Editor” tab 
(5) Press the “Engage EdiFng Mode” bu?on. 
(6) Le<-mouse click on the image.  Each mouse click will add a row to the table. 
(7) Once you have added all the dither posiFons, turn off the “Engage EdiFng Mode.”  
(8) Make the pa?ern available in the selecFon combo-box by pressing the “Add to Dither 

List” bu?on.  The name must be unique and not currently in the list of dither pa?erns.  If 
the name is already in the list, a dialog will prompt the user to change the name.  

(9) OpFonal: Save the dither to an external file on disk.  Pressing the “Save” bu?on opens a 
file browser dialog and you can specify a name for the file and where it should be stored.   
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Figure 26 Dither Control: Image dither ediEng 

    If you created a posiFon that you no longer wish to have in the table, select the row and then 
press the green “-“ bu?on to the le< of the dither table.  If you wish to start over, you can clear 
the table using the “Clear Table” bu?on.   
     The dither control can be very simple to use; select a pa?ern, scale it, and press GO.  You do 
not need to use the visualizaFon tools to make the system work.  However, the DSS image 
display provides more feedback to the observer during operaFon and can be extremely useful.  
 
5.6 Filter Wheel Controls 
      Most of the Fme observers will use the filter selecFon controls on the main panel to change 
the filter; however, occasionally the mechanism needs to be reiniFalized and the observer 
needs to access the dedicated filter control panel.  The filter wheel control is accessible from 
the Tools > WIRC Filter Wheel Controls menu opFon.   
     At the top of the panel are two toggle bu?ons: (1) Connect to Filter Wheel and (2) Motor Init. 
The Connect to Filter Wheel bu?on has an indicator light that will be green if the connecFon is 
successful.  The system a?empts to connect to the filter wheel module in the server and 
retrieve the list of installed filters.  If the indicator is red on this bu?on, it means that the 
connecFon to the filter wheel module was unsuccessful.  In this event, ask the support 
astronomer to check the RS232 connecFon to the filter mechanism and to reiniFalize the filter 
control module directly from the command line.  Once the problem has been corrected, you can 
press the Connect to Filter Wheel bu?on and it will connect, retrieve the list of filters in the fore 
and a< wheels, and display the filters currently in the opFcal path.   
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Figure 27 Filter Wheel Controls 

      If one or more of the current filters (see current filter fore and a< text boxes on the control) 
appear as “not named,” then the filter wheel module needs to be iniFalized.  In the upper right 
corner of the control there is a “Motor Init” bu?on that becomes acFve once the connecFon to 
the filter wheels is established.  Pressing the “Motor Init” bu?on forces both wheels to go 
through a homing sequence and reestablishes the correct current filters, which may take a 
couple of minutes.  You should see the filter names changing as the wheels are rotated.    
      The middle of the control panel has a small text field where the commands set to the 
ArcVIEW server are displayed in blue and the responses from the server are displayed in green.  
The wheel icons should rotate while the wheels are moving, and addiFonal informaFon is 
displayed in the set of indicators at the bo?om of the control.  The indicators are green if 
acFvated or grey if not.  These indicators provide low-level informaFon about what the 
mechanism is doing.  For example, one or more of the indicators will be acFve whenever the 
mechanism is acFve, including the status of homing, moFon, and power to name a few.  
     Directly under the “Connect to Filter Wheel” bu?on there are controls for selecFng a filter 
and moving that filter into the opFcal path.  There are two tabs in the panel: (1) Independent 
Control and (2) Joint Control.  Observers are cauFoned that the wheels should be moved 
independently, and the Joint Controls should be avoided.  The joint controls stopped working 
properly a<er the filter locaFons were modified to support polarizaFon observaFons.  The 
process for selecFng a filter combinaFon follows: 

(1) Select the filter in the FORE combo-box. 
(2) Press the associated MOVE bu?on. 
(3) The Move bu?on indicator turns RED while the move is in progress. 
(4) The Move bu?on indicator turns back to GREEN once the move is complete. 
(5) Repeat steps 1 through 4 for the AFT wheel. 
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     In general, observers should not need to work with the WIRC Filter Wheel Controls panel 
since the so<ware is started by the support astronomers.  Observers will need to worry about 
the filter wheels only if the server needs to be restarted during the night.  The “Connect to Filter 
Wheel” and “Motor Init” bu?ons are probably the only controls that the user needs to work 
with.  
     Changing the filters in one or both of the wheels is a major project, so you only have the 
filters that are installed to choose from. The filter wheels are inside the dewar and cannot be 
changed with opening the instrument.  The following table shows the locaFon and name of 
each filter in both the fore and a< wheels. 
 

        Fore Aft 
1 PG H2 (2.12) 
2 Diffuser K-cont (2.27) 
3 H-cont (1.57) H (1.64) 
4 CO (2.29) J (1.25) 
5 Open Ks (2.15) 
6 GRISM Open 
7 BrGamma (2.17) He 

Table of installed filters as of 9-19-2023 
 
5.7 Mask Mechanism Controls 
     The mask mechanism inserts a mask into the opFcal path that is essenFal for making 
polarizaFon measurements.  The mask control GUI is accessible from the Tools > WIRC-Pol Mask 
Mechanism Controls menu opFon.  The GUI is very simple and can automaFcally connect to the 
mechanism controller when the so<ware starts.  There is a Connect bu?on on the front panel 
with an indicator light that turns green when the connecFon is made.  The mechanism is 
automaFcally iniFalized when the connecFon is established and places the mask out of the 
opFcal path.  There is an animated GIF that simulates the mask being inserted or removed and 
this GIF should reflect the current state of the mechanism.  Once the connecFon has been 
established, the “Insert Mask” bu?on will be enabled.  If the mask is inserted, the “Remove 
Mask” bu?on is enabled and the “Insert Mask” bu?on is disabled.  Once the mask mechanism 
has been iniFalized, you can close the control and insert/remove the mask using the controls on 
the main panel. 
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Figure 28 WIRC-POL Mask Mechanism 

    The Comm Log tab displays a log of the communicaFon between the mechanism controller 
and the so<ware.  This display is useful parFcularly when you need to debug a problem.  You 
can perform a mechanism test using the Test bu?on on the panel.  The mechanism “Test” first 
inserts the mask into the opFcal path and then removes it.  In the process it sends commands to 
the controller that can be monitored in the communicaFon log. 
 
5.8 PolarizaFon Mechanisms – Newport Controller 
     The presence of two slide mechanisms at the front of the instrument are what turns WIRC 
into WIRC-Pol.  The slide mechanisms insert opFcs into the opFcal path that are mounted within 
rotaFon mechanisms that allow them to rotate.  In total, there are 4 mechanisms (2 slides, 2 
rotators) and they are all controlled by a Newport XPS-D ethernet-based mechanism controller.  
All four mechanisms are controlled via TCP/IP socket connecFons to the XPS-D controller.   
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Figure 29 WIRC-POL PolarizaEon Mechanisms 

     The Tools > WIRC-Pol Newport Controller menu item displays the detailed instrument 
controls for all four mechanisms.  The most import of these controls is the “IniFalize” bu?on 
that establishes the socket connecFons and then homes the mechanisms and put them into the 
default state (i.e., opFcs out of the opFcal path, at default rotaFon angle).  By default, these 
mechanisms are automaFcally iniFalized when the so<ware is opened.  All the other bu?ons 
and controls are disabled unFl iniFalizaFon is complete.   
    The two slide mechanisms (i.e., polarizaFon opFc, half-wave plate opFc) have equivalent 
control panels.  When the mechanism is iniFalized, it displays the status of the command and 
monitoring sockets with a green indicator light if the connecFon is successful.  The state of the 
slide mechanism is indicated by the OPTIC IN and OPTIC OUT indicator lights displayed on the 
bu?ons. The stage posiFon and a status message are also displayed in text in the middle of each 
controller panel.  By default, the observer can only insert or remove the opFc.  If you need to 
debug an issue that requires moving the mechanism to an intermediate posiFon, you must first 
enable the move by selecFng the “Enable Move” bu?on.  SelecFng this bu?on enables the 
Move bu?on on the same panel.  You can then move the mechanism to any intermediate motor 
posiFon by entering the motor step posiFon in the text field to the right of the Move bu?on.   
VerificaFon that the move is taking place is provided by the changing stage posiFon and status 
messages.   
    The two rotaFon mechanisms have control panels that are designed to allow the opFcs to be 
rotated.  If the iniFalizaFon is successful, the command and monitoring socket indicator lights 
are turned green.   The stage posiFon and a status message are displayed in the panel and 
update visually when the mechanism is acFve.  When the rotaFon mechanisms are used while 
making polarizaFon measurements, it is typical to set the rotaFon to one of 4 preset posiFons: 
(1) 0 degrees, (2) 22.5 degrees, (3) 45 degrees and (4) 67.5 degrees.  Each of the 4 preset 
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posiFon indicators is a bu?on that turns red while the move is in progress and then green when 
the mechanism is at the desired rotaFon.  The preset rotaFon angle controls are replicated on 
the WIRC-Pol main panel.  If necessary, the Move bu?on and the associated text field can be 
used to rotate the opFc to an arbitrary angle. 
     At the Fme of this wriFng, the polarizaFon slide mechanism and the associated rotator are 
out of service and the controls are intenFonally disabled.  Only the half-wave plate slide and its 
associated rotator are currently in service.  The polarizaFon mechanism was necessary when 
the system was being calibrated, but is not required when making polarizaFon measurements.  
There are no plans to put the polarizaFon slide and its rotaFon mechanism back into service.  
The IniFalize bu?on is disabled a<er iniFalizaFon.  If you need to reiniFalize the mechanism for 
some reason, you can repeat the iniFalizaFon by pressing the Reset bu?on.  
 
5.9 Sextractor source analysis 
      Sextractor is an analyFcal tool developed by Emanuel BerFn that is extremely useful for 
extracFng star posiFons from an image.  The intenFon in this secFon is not to teach an observer 
how to use Sextractor but to explain how it’s integrated into the WIRC-Pol code.  The Tools > 
Sextractor Source Analysis menu item pulls up a GUI that can be used to run Sextractor from 
within the WIRC-Pol so<ware.  When an image is produced by the WIRC-Pol so<ware, the file’s 
path is automaFcally added to the “Select Fits Image” text field.   
 

 
Figure 30 Sextractor 

      Sextractor works by running a command in a terminal and passing it a configuraFon file with 
the parameters to be used in the extracFon along with the path to the file to be examined.  The 
code constructs the required configuraFon file based on the entries in the GUI, and then 
constructs the command line to execute within the terminal.  Once the analysis has been 
completed, the output of Sextractor is parsed and the sources are displayed in the “Extracted 
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Sources” panel.  SomeFmes the list of extracted sources needs to be filtered to remove 
overlapping stars, reject saturated stars, and cosmic rays that are mistaken for stars by the 
algorithm.  The Filtered Sources tab contains controls for configuring the filtering such as se`ng 
the minimum distance between stars.  You can plot a histogram of the signal-to-noise, flux, or 
focus (i.e., FWHM) based on the filtered list.   
     Sextractor can calculate a very large number of parameters.  It determines which parameters 
to calculate based upon a file provided on the command line that lists the parameter names.  
The Output Parameters may be configured on the Output Parameters tab.  The way this works is 
by having a set of configuraFons that have predefined lists of parameters for Sextractor to 
calculate.  The following predefined parameter lists are available by default: 

(1) Coordinates Only 
(2) Pixel Coordinates Only 
(3) World Coordinates Only 
(4) Scamp Output ConfiguraFon 
(5) Out-of-Focus Donut ConfiguraFon 
(6) Custom output configuraFon 

By default, the Out-of-Focus Donut ConfiguraFon is used because it constructs focus surfaces, 
using the donut method for determining best focus.  The Scamp configuraFon is required if you 
intend to use Scamp to solve the astrometric soluFon for the image and produces catalogs in 
the required format.   
     The Sextractor control panel is not intended as a fully funcFonal system for configuring and 
running Sextractor.  The code is primarily intended to provide support for star selecFon for 
guiding and as a systemaFc way of determining the current seeing. 
 
5.9.1 Focus Analysis 
     Once you have determined the locaFon of all of the stars in an image by running Sextractor, 
you can easily evaluate the seeing in the image.  The Tools > Sextractor > Focus Analysis bu?on 
opens a display that operates on the current list of sources idenFfied by Sextractor.  Pressing the 
“Focus Analysis” bu?on in the top le< corner of the panel fits a Gaussian to each star in the list 
and constructs a histogram of the FWHM values.  The mean, median, and standard deviaFon of 
the FWHM distribuFon is displayed under the histogram.  The median is by the far the best 
measure of this distribuFon since a few galaxies can skew the mean to the high side and the hot 
pixels in the image can skew the value lower.  If you are seeing cosmic rays and hot pixels being 
confused with stars, try increasing the DETECT_MINAREA parameter on the Sextractor main 
panel.  Increasing this value effecFvely rejects cosmic rays and hot pixels from the FWHM 
histogram distribuFon.  
    The bo?om half of the focus analysis display contains a table that presents the coordinates of 
each located star, the FWHM, asFgmaFsm, peak intensity, and background intensity.  Above the 
histogram is a panel that allows you to segment the image into a grid and calculate the mean 
value of the FWHM for each grid cell.  The grid spacing is set by the Grid Spacing spinner control 
in the upper right corner of the “Focus Map Analysis” panel.  The process bu?on allows you to 
export the grid file as both a text file and a FITS image.  This funcFon can produce useful 
informaFon—parFcularly if the image is of a densely populated porFon of the galacFc field 
where you have mulFple stars in each grid unit.  If you want to use this funcFon, choose a field 
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with lots of stars that are not overlapping (i.e., no closed clusters).  You can also display the 
focus and asFgmaFsm surfaces as mesh graphs by pressing the “Construct Focus Surface” or 
“Construct AsFgmaFsm Surface.” 

 
5.9.2 Focus Graph Analysis 
       When you’re focusing using the Tools >Image Display Control > Tools > Autofocus Controls, 
you are basing your esFmate of focus using a single star.  Why not take all the stars into 
account?  You can do this with the Focus Graph Analysis panel. 
    Let’s assume that you have already run the Autofocus and you created a set of files at 
different focus values.  The “Focus Graph Tool” has a bu?on in the upper le< corner that will 
bring up a file browser and allow you to select the set of focus images. Once you select the 
images, they will appear as a list in the viewport below the bu?on.  Once the files have been 
selected, simply press the Process bu?on.  Each image will be processed by Sextractor, and if 
you check the “Perform Gaussian Fit” checkbox, a Gaussian fit will be done on each idenFfied 
star.   
     A graph of the FWHM as a funcFon of focus value is displayed in the lower right corner of the 
“Focus Graph Tool.”  A similar graph of the donut metric as a funcFon of focus value is displayed 
in the lower le< corner.  The donut metric is essenFally a measure of the area of the point 
spread funcFon that can be used to evaluate focus when the images are too far out of focus to 
fit with Gaussians.   
 
6.0 Using the Instrument 
 
6.1 CalibraFons 
     There are quite a few ways you can obtain calibraFons, but the simplest is probably to write a 
script to carry out the observaFons automaFcally.  There’s a good chance that a script already 
exists to do what you need to do.  Look through the scripts folder and find a script that’s close 
to what you need to do.  Make a copy of the script in the same folder and reopen it.  Now you 
can modify the script to meet your needs.   
     To reduce the data later you need the following calibraFon images: 

(1) Bias frames: Insert Br-gamma 2.25 in the FORE wheel and J_1.25 in the AFT wheel.) 
(2) Dark frames: If you’re doing exposures long enough to warrant them, you will need 

mulFple frames at each exposure Fme you intend to use during observing. 
(3) Flat Field Images: You will need a set of flat field images in each of the filters you’re 

planning to use.  The opFmum signal level is ~ 60% of full well capacity.  Make sure that 
the image is not saturated. 

     Everyone has a parFcular way they wish to reduce their data and therefore everyone needs 
slightly different calibraFon sets.  It’s simple to take bias frames by pu`ng in the blocking filters, 
se`ng the exposure Fme to the minimum (0.923 seconds), pu`ng the system in conFnuous 
mode, and pressing the GO bu?on.  The system will conFnuously take images unFl you disable 
the conFnuous bu?on.  But when you’re taking darks or flat field images, you need to change 
the exposure Fme or filters, respecFvely.  It’s much easier to setup a script once (or modify one) 
and then just let the scripFng system carry out your calibraFon observaFon.  The one thing to 
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be careful of is to really check that you’ve spelled the filter names correctly.  The code isn’t 
smart enough to guess what you meant when you used J as the filter name rather than J_(1.25).  
The code will detect the error but it will just print the warning to the execuFon log and you 
might not have noFced it.   
      When you’re taking flat field images with the dome closed, you can specify which lamps to 
turn on/off for each filter.  Check the exposure Fme and lamp you’re using for each filter and 
take an image with those se`ngs before starFng your script.  Palomar staff will open the mirror 
covers for you. 
     You can also take flat field images at dawn or dusk by le`ng the telescope dri< (i.e., don’t 
track) and taking enough images that any stars are removed when the images are median 
combined.  The hardest thing about taking sky flats is that the sky is constantly changing (ge`ng 
darker or lighter), and you may need to keep changing the exposure Fme to avoid saturaFon or 
to get enough signal.  You want to measure the flat field structure with good signal-to-noise and 
you don’t want to saturate the image.  In general, sky flats can create be?er correcFons, but 
they are more difficult to get right.  
 
7.0 First Steps when On-Sky 
 
8.0 Calibrate the image coordinates, PoinFng 
    Verifying telescope poinFng is a simple process where the telescope operator slews to a 
bright star in the SAO catalog.  You may discover that the star will land exactly at the center 
(marked by the telescope boresight marker) of the image.   Typically, the star will be close but 
not quite on the center pixel.  You can use the “Move Target to Bullseye” funcFon to place the 
star directly at the image center or offset into a quadrant.  Once you’ve placed the star where 
you want it, ask the telescope operator to “X” to set the telescope poinFng at this locaFon. 
 
    When you first get on-sky a<er compleFng your calibraFons, there are a couple of things you 
need to do.  A<er verifying poinFng, focusing is next.  The telescope operator will have set the 
focus to the last best focus.  Take an image, place the guide box cursor on a star and check the 
FWHM.  Here are several ways to obtain best focus: 
 
7.1 Focus: Manual Method 

(1)  Select a star in the image (not saturated but bright enough to measure easily) and place 
the guide box cursor on it. 

(2) Open the PSF graph.  Make sure that measurements are enabled and clear the graph. 
(3) Engage the ConFnuous bu?on. 
(4) Press the GO bu?on to start taking images. 
(5) Watch the PSF graph begin plo`ng. 
(6) On the main panel’s “Telescope” tab, increment the focus in one direcFon using the 

focus offset arrows.  ConFnue taking images and offse`ng the focus value unFl you find 
the minimum FWHM.  
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(7) OpFonal: Once you’re happy with the focus, take an image and then run it through 
Sextractor and the Focus Map control to record the best focus and report it to the 
telescope operator. 

 
7.2 Focus: Autofocus Control 
     The easiest way to get best focus is to open the Autofocus control (Image Display Controls > 
Tools > Autofocus).  Set the starFng focus value to a value below the esFmated best focus.  Set 
the focus increment (0.2 for a coarse pass, 0.1 for a fine pass) and number of focus steps 
(default = 10) and press the “Perform Autofocus” bu?on. The code will take an image, 
increment focus, and repeat unFl the total number of images has been fulfilled.  Once the 
funcFon completes, it will return the “Perform Autofocus” icon (icon changes to “Stop 
Autofocus” while it’s running) and calculate the best focus based on fi`ng parabolas to the 
focus curve in both X and Y.  The parabolic fit may not work very well if you haven’t sampled 
both sides of the well correctly or if the signal is noisy.  As a result, you may be be?er able to 
idenFfy the parabolas’ minima by eye.  Verify that the telescope is at the best focus at the end 
of the process.   
 
7.3 Focus: Scrip&ng 
    One of the easiest scripts to write is a focus script.  You can focus the instrument by running a 
script that follows this formula: 

(1) Set the iniFal focus (FOCUSGO) to a value below best focus 
(2) Take an image 
(3) Increment the focus (FOCUSINC) by a small amount (0.05 to 0.2) 
(4) Take another image 
(5) Repeat steps 3 and 4 unFl you’re well above focus (between 10 and 20 steps) 

 Once the script has completed, open the Tools > Sextractor > Focus Graph Analysis panel and 
add the image files you just created to the list.  Press the Process bu?on and the code will run 
Sextractor on each image and calculate and plot the median FWHM and the Donut metric (for 
very out-of-focus images) as a funcFon of focus value.  There should be a much stronger and 
less noisy signal of the seeing measurement since the plo?ed values are based on all of the stars 
in the field.  This method will produce the best esFmate of focus, but it does take a li?le more 
effort.  If you want the best results, use a crowded galacFc plane field with several thousand 
detectable stars in the image.  Try to avoid closed clusters where it’s difficult to separate one 
star from its neighbors.   
 
9.0 Typical Observing Scenarios 
      Here are a few comments on a couple of the more common observing scenarios.   
 
9.1 TransiFng exoplanet light curves 
     WIRC-Pol has been used many Fmes to measure light curves, parFcularly light curves for 
exoplanets transiFng their stars.   The guiding system was originally devised to improve the 
instrument’s ability to measure light curves.   
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     When you are measuring the flux of a star, you don’t want the star moving during the 
observaFon because it increases the noise.  Ideally, you want the star to fall on the same pixels 
throughout your observaFon sequence.  If the star is very sharp and well-focused it will fall on a 
very small number of pixels and even small posiFon shi<s could generate large flux changes.  To 
get around this, we would defocus the telescope slightly to increase the number of pixels the 
light falls on.  When you defocus the telescope, you may not be able to use the Gaussian fit 
algorithm to monitor telescope offsets because the Gaussian algorithm simply won’t fit an out-
of-focus donut.  The center of mass algorithm was developed to allow out-of-focus images to 
allow guiding in this circumstance.  When we were first measuring light curves with WIRC this 
was the pa?ern: Defocus the telescope, then use center of mass for guiding, then apply 
background subtracFon and flat fielding in real Fme. 
    The current filter list contains a diffuser in the FORE wheel that can be combined with any of 
the broadband filters in the AFT wheel.  The diffuser spreads out the point spread funcFon like 
defocusing the image does; however, the PSF with the diffuser in the opFcal path sFll produces 
point spread funcFons that can be accurately assessed by the Gaussian fit algorithm.  Including 
the diffuser in the WIRC-Pol instrument simplifies measuring exoplanet light curves. 
Here are the steps you should take when you’re measuring a light curve: 

(1) IdenFfy the target star in the image and place the guide box cursor on it. 
(2) Open the cross-secFon graph so you can assess the signal-to-noise for the given 

exposure Fme. 
(3) Make sure that you have a good sky background to subtract and set it up to be 

automaFcally subtracted.   
(4) Open the Autoguiding panel and press the Locate Guide Stars bu?on.  Examine the 

cross-secFon for each of the selected stars and reject those that are either saturated or 
with insufficient signal-to-noise. 

(5) Once you’re happy with the set of guide stars, save the list so it can be retrieved in case 
of emergency.  You may have to increase the number of guide stars requested if you 
need to reject too many. 

(6) Turn on conFnuous mode. 
(7) Press GO bu?on. 
(8) While the observaFons are being carried out, monitor the guide graph, the cross-secFon 

of the target star and the maximum graph.  These graphs will help you assess how the 
sky is changing during your observaFon.   

(9) O<en the sky background changes over the course of the night (i.e., moonlight, city 
lights, etc.) and you want to have a consistently good background image to be 
subtracted.  If you need to take a background image, you can turn off conFnuous 
imaging, wait for the system to stop, offset to the background posiFon, take an image, 
set the current image as the background, return to your original locaFon, turn on 
conFnuous imaging, and press GO.  If you have done this quickly enough (within a few 
minutes) the stars should sFll be in the guide boxes and the light curve measurement 
can conFnue.  If they aren’t, use the paddles to nudge them inside. 

     The WIRC-Pol guiding so<ware should allow you to keep your target star within +/- 1-2 pixels 
over the course of an enFre night’s observing.   
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9.2 Dithering 
     Dithering in mulFple filters is one of the more common observing scenarios.  It’s simple 
enough to implement manually: Open the dither control, run a dither pa?ern, then change the 
filter and rerun the dither pa?ern in the second filter.  You can follow this pa?ern to write a 
simple script that will execute the pa?ern 3 Fmes with different exposure Fmes and different 
filters.  The following is an example script that will acquire 3 dither pa?erns of 5 images each in 
three different filters (J,H, and K). This script can be easily extended to acquire complex sets of 
mulF-band images with the WIRC-Pol instrument.  
 
RETRIEVE_DITHER_IMAGE 
SET_DITHER_PATTERN DITHER_5_SIMPLE 
SET_DITHER_SCALE 100.0 
IMAGENUMBER 10 
FILTER FORE OPEN 
FILTER AFT J_(1.25) 
EXPTIME 120.0 
EXECUTE_DITHER 
IMAGENUMBER 20 
FILTER AFT H_(1.64) 
EXPTIME 60.0 
EXECUTE_DITHER 
IMAGENUMBER 30 
FILTER AFT Ks_(2.15) 
EXPTIME 30.0 
EXECUTE_DITHER 
 
10.0 In Conclusion 
      The so<ware described in this manual represents an a?empt to simplify and streamline the 
interface to the WIRC-Pol instrument.  ParFcular a?enFon has been put on improving the dither 
control system and implemenFng auto-selecFon of guide stars.  The goal has been to simplify 
the interface and remove components that are rarely used.  The auto=selecFon of guide stars is 
probably the biggest new feature added to this build.  The dither control has been plagued by 
problems—parFcularly when a?empFng to stop a dither in the middle of execuFon.  The focus 
has been on improving the reliability of the components—parFcularly during aborts or a?empts 
to stop execuFon.  The other concern was to create a small, simple control from the large and 
rather complex control that was available in WIRC-Pol-2 
     The build documented here is deployed as version 3_100_00 (i.e. 3.1) and it’s currently 
deployed on the newton.palomar.caltech.edu computer for tesFng.   
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11.0 Programmer’s Note:  How the so[ware works 
 
     The WIRC-Pol so<ware is wri?en in Java and any runFme Java installaFon should run it 
without problem.  A Java program is typically packaged into a JAR file (*.jar) and the program 
runs by passing the Jar file to the Java runFme.  The startup process works in the following 
sequence: 

(1)  Open a terminal window and type ‘wircpol3’ into the window and hit Enter. 
(2) The operaFng system looks in all the $PATH environmental variable directories for a file 

or link named “wircpol3.”  A symbolic link exists in the /home/developer/bin2 directory 
named “wircpol3” that points to the locaFon where the code is installed. 

(3) The deployed code is located in the directory /rdata/so<ware/instruments on the 
newton.palomar.caltech.edu computer.  Each instrument has its own subdirectory and in 
this case the code is stored in the wirc3 subdirectory. 

(4) When a completely new build is deployed, a new subdirectory is created that matches 
the version number of the code.  For example, the current version of the code is stored 
in a directory named WIRC3_1_00_00.  This indicates that this is the first major release 
of this code with no major or minor revision numbers.  A major new release would be 
Ftled WIRC3_1_01_00 while a minor release would look like WIRC_1_00_01.  Frankly, 
what’s considered a major release vs. a minor release is a li?le vague.  Any Fme a new 
library needs to be added to the library path requires a major release.  Similarly, the 
presence of a new capability or support for a new mechanism or subsystem will be 
marked by a major release increment.  On the other hand, minor releases are mostly 
bug fixes or minor variaFons that don’t require major tesFng plans. 

(5) When you invesFgate a parFcular release subdirectory, you will find a very predictable 
folder structure.  The first we need to consider is the ~/bin directory.  The bin directory 
contains the script file that starts the so<ware. 

(6) The script file is very simple.  The first line changes directory to the folder containing the 
JAR file (/rdata/so<ware/instruments/wirc3/WIRC3_1_00_00) and the second line starts 
the program:     java -jar WIRC3.jar  

     In summary, you type “wircpol3” in a terminal, the operaFng system finds wircpol3,and 
points to the executable script file in the bin directory of the release. 
     Upon startup, the so<ware needs to know how to find resources such as images for icons, 
banners, etc.  You can query the USERDIR from inside the program which tells you the directory 
where the process started.  In general, the USERDIR is the directory that contains the JAR file.  
Because of this feature, when you deploy resources, you can place them relaFve to the 
USERDIR.  If you look at the structure of a deployed version of the code, you will see a 
predictable directory structure. 
Directory                       Purpose 
bin                                  contains executable scripts for starFng the so<ware 
bitmaps                bitmaps used by the JAI and JSKY components 
colormap   colormaps used by the JSKY FITS display components 
config    contains configuraFon and iniFalizaFon files 
images   contains images, icons, banners, etc. used by the GUI 
lib   library files that contain supporFng JAR files 
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logs   locaFon for some small logs (many stored in configured locaFons) 
temp   locaFon for wriFng temporary files, many of which are wri?en in 

configured locaFons 

 
Figure 31 Directory structure of a deployed code package 

     Java programs are organized into packages and in the case of WIRC-Pol, the code is 
encapsulated in the edu.caltech.palomar.instruments.wirc directory.  The main class that starts 
the program is WIRCMain.java.  The code is configured to make the WIRCMain class the main 
class in the JAR file.  Within the WIRC package, there are subdirectories that encapsulate 
different components of the system.  For example, there is a scripts subdirectory that contains 
all of the code supporFng the scripFng system for WIRC-Pol.  Similarly, there is a package for the 
Newport stages that supports the polarizaFon mechanisms.  Another package supports the 
entrance mask used in polarizaFon observaFons.     
    The system is also controlled by a set of configuraFon files (e.g., config directory) that 
influence many aspects of the systems operaFon.  The TelescopeIniReader class is responsible 
for reading the “telecope.cfg” file in the config directory.  Values in the configuraFon file are 
arranged in secFons and each secFon includes mulFple key, value pairs.  The 
TelescopeIniReader reads the file and changes its internal variable to reflect the values in the 
file.  In the case of the TCS, the file contains SERVERNAME and SERVERPORT fields that are read 
when the system starts.  An instance of the TelescopeIniReader is passed to the 
P200Component.  The P200Componet uses the values in the configuraFon file to set the IP 
address and socket number when connecFng to the TCS.   
    Any Fme the code requires a default value or a path to a resource, there is probably an entry 
in a configuraFon file that determines the value.  In general, the code is wri?en to make it as 
portable as possible so it’s easy to deploy it in a new context and on a new computer system.  
There are quite a few configuraFon files and many ways to use them.  ConfiguraFon files are 
absolutely essenFal to the operaFon of the instrument.  
     There are two major components that are not part of the WIRCI-Pol package but are 
essenFal for operaFons: (1) DHEControl and (2) P200Component.  The DHEControl encapsulates 
all interacFons with the ArcVIEW server that controls the detector.  WIRC-Pol uses the ArcVIEW 
server to control the detector and the DHEControl instanFates the TCP/IP sockets connecFons 
to the ArcVIEW server.  When the program starts, an instance of the DHEControl is created that 
contains the TCP/IP management mechanisms for connecFng to the control, blocking, and 
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asynchronous ports.  Most commands are sent on the control socket, and asynchronous 
messages from the server are also monitored.  The WIRCDHEControl directly inherits from the 
DHEControl class and implements any interacFons that are specific to WIRC-Pol.   
     The DHEControl contains all the code necessary to talk to the ArcVIEW server and maintains 
a class called DHEObject that represents the state of the server at any point in Fme.  For 
example, when the system starts up, it connects to the ArcVIEW server and queries the server 
for every parameter that the server supports.  The DHEControl parses the responses from the 
server and sets the values of the variables in the DHEObject represenFng the state of the server.   
     For example, I just started the GUI and the exposure Fme appears as 90.0 seconds.  The 
DHEControl queries the ArcVIEW server over the command port for the current value of the 
exposure Fme.  The response comes from the server and the DHEControl parses the response, 
turns the ASCII into a double value, and sets the exposure Fme variable in the DHEObject.  To 
properly update the value of the exposure Fme in the GUI, the code that updates the value 
must be executed in the event dispatch thread.  The way to do this is for the GUI to register as a 
listener for property change events propagated by the DHEObject.  When the DHEControl calls a 
method in the DHEObject to set the exposure Fme, the method checks if the value of the 
exposure Fme has changed.  If the value has changed and property change event is propagated 
to the GUI.  The GUI (i.e., WIRC2_ExposureFrame) is registered as a listener for property change 
events on the DHEObject so that any Fme a value in the object changes, the GUI can process 
that event.  This is an example of Model-View-Controller architecture.  The model is the 
DHEObject that contains the state of ArcVIEW server.  The view is the GUI 
(WIRC2_ExposureFrame) that presents the state of the system to the observer.  The controller in 
this case is the code in the GUI that responds to changes in the DHEObject by changing the 
values on the view.  Everything in the WIRC-POL code works this way using the model-view-
controller paradigm.  
    The other example menFoned above is the P200Component.  The P200Components 
encapsulates all interacFons with the P200 telescope.  The P200Component is the class that 
maintains the TCP/IP connecFons to the TCS and queries the telescope for telemetry 
informaFon.  The P200Component also support methods for offse`ng the telescope, changing 
the focus, and monitoring the telescope’s posiFon.  The code needs to be mulF-threaded so 
that the system can conFnuously update the posiFon during a move.  The code supports a 
monitoring thread that updates the TCS coordinates at about 4Hz.  When you a?empt to offset 
the telescope, the P200Componets spawns a thread that executes the offset using a TCS 
command.  Simultaneously, the monitoring thread is listening for changes in telescope posiFon 
and updaFng the values of the TelescopeObject that maintains the state of the telescope. The 
GUI (several components) is registered as a listener to the TelescopeObject property change 
events. When the value of the TCS coordinates changes the TelescopeObject propagates the 
events to the GUI and the GU presents the new coordinates to the observer.  
     Model-View-Controller is the guiding paradigm for all the Java code.  Every value you see on 
the GUI is backed by this system.  In some cases, the component only has a few variables and 
it’s not necessary to separate the object state from the component.  In these cases, the 
component directly hosts the state variables and propagates the events directly to the GUI.  A 
good example of this is the Newport stage control.  The Newport XPS controller supports 4 
mechanisms (2 slides and 2 rotaFon mechanisms), and each of these mechanisms is controlled 
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by an instance of the XPSDNewportController class.  The XPSDNewportController class is both a 
component that supports the communicaFon with the Newport controller and the object that 
reflects the state.  The GUI (NewportControllerFrame and/or the main panel) registers as a 
listener to each instance of the XPSDNewportController.   
     The Java code base make extensive use of several major development packages that should 
be menFoned.  The image display system for FITS images is based on the JSky archive, an ESO 
project from the early 2000’s.  The ephemeris calculaFons are based on JSkyCalc wri?en by John 
Thorstensen at Dartmouth.  The JSkyCalc code is directly incorporated into the Palomar Java 
build tree as the edu.dartmouth.jskycalc package.  In a similar way, the Aperture Photometry 
Tool wri?en by Russ Laher at IPAC is incorporated into the build tree in the edu.caltech.ipac 
package.  The WIRC-Pol so<ware makes use of each of these packages for performing 
calculaFons to supply informaFon for the FITS header and for producing graphs and telemetry 
plots.   


